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Über diese Anleitung Was bedeuten die Symbole und Formatierungen? 

1 Über diese Anleitung 
enthält: 

Was bedeuten die Symbole und Formatierungen?........................................................................5 
Wie ist diese Anleitung aufgebaut?................................................................................................6 

202 

Im ergänzenden "Programmierhandbuch CoDeSys V2.3" erhalten Sie weitergehende Informationen 
über die Nutzung des Programmiersystems "CoDeSys for Automation Alliance". Dieses Handbuch 
steht auf der ifm-Homepage als kostenloser Download zur Verfügung:  
a)  www.ifm.com > Land wählen > [Service] > [Download] > [Steuerungssysteme] 
b)  ecomatmobile-DVD "Software, tools and documentation" 

Niemand ist vollkommen. Wenn Sie uns Verbesserungsvorschläge zu dieser Anleitung melden, 
erhalten Sie von uns ein kleines Geschenk als Dankeschön. 

© Alle Rechte bei ifm electronic gmbh. Vervielfältigung und Verwertung dieser Anleitung, auch 
auszugsweise, nur mit Zustimmung der ifm electronic gmbh. 

Alle auf unseren Seiten verwendeten Produktnamen, -Bilder, Unternehmen oder sonstige Marken sind 
Eigentum der jeweiligen Rechteinhaber. 
 

 

1.1 Was bedeuten die Symbole und 
Formatierungen? 

203 

Folgende Symbole oder Piktogramme verdeutlichen Ihnen unsere Hinweise in unseren Anleitungen: 

 

 GEFAHR 
Tod oder schwere irreversible Verletzungen sind zu erwarten. 

 

 WARNUNG 
Tod oder schwere irreversible Verletzungen sind möglich. 

 

 VORSICHT 
Leichte reversible Verletzungen sind möglich. 

 

ACHTUNG 
Sachschaden ist zu erwarten oder möglich. 

 

 HINWEIS 
Wichtige Hinweise auf Fehlfunktionen oder Störungen. 

 

 Info 
Weitere Hinweise. 

 

http://www.ifm.com/�
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Über diese Anleitung Wie ist diese Anleitung aufgebaut? 

► ... Handlungsaufforderung 

> ... Reaktion, Ergebnis 

 ... "siehe" 

abc Querverweis 

[...] Bezeichnung von Tasten, Schaltflächen oder Anzeigen 
 

 

1.2 Wie ist diese Anleitung aufgebaut? 
204 

Diese Dokumentation ist eine Kombination aus verschiedenen Anleitungstypen. Sie ist eine 
Lernanleitung für den Einsteiger, aber gleichzeitig auch eine Nachschlageanleitung für den versierten 
Anwender. 

Und so finden Sie sich zurecht:  

 Um gezielt zu einem bestimmten Thema zu gelangen, benutzen Sie bitte das Inhaltsverzeichnis. 

 Mit dem Stichwortregister "Index" gelangen Sie ebenfalls schnell zu einem gesuchten Begriff. 

 Am Anfang eines Kapitels geben wir Ihnen eine kurze Übersicht über dessen Inhalt. 

 Abkürzungen und Fachbegriffe  Anhang. 

Bei Fehlfunktionen oder Unklarheiten setzen Sie sich bitte mit dem Hersteller in Verbindung: 
 www.ifm.com > Land wählen > [Kontakt]. 

Wir wollen immer besser werden! Jeder eigenständige Abschnitt enthält in der rechten oberen Ecke 
eine Identifikationsnummer. Wenn Sie uns über Unstimmigkeiten unterrichten wollen, dann nennen 
Sie uns bitte diese Nummer zusammen mit Titel und Sprache dieser Dokumentation. Vielen Dank für 
Ihre Unterstützung! 

Im Übrigen behalten wir uns Änderungen vor, so dass sich Abweichungen vom Inhalt der vorliegenden 
Dokumentation ergeben können. Die aktuelle Version finden Sie auf der ifm-Homepage: 
 www.ifm.com > Land wählen > [Service] > [Download] > [Steuerungssysteme] 
 

 

http://www.ifm.com/�
http://www.ifm.com/�
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Sicherheitshinweise Wichtig! 

2 Sicherheitshinweise 
enthält: 

Wichtig!...........................................................................................................................................7 
Welche Vorkenntnisse sind notwendig? ........................................................................................8 

213 
 

 

2.1 Wichtig! 
6091 

Mit den in dieser Anleitung gegebenen Informationen, Hinweisen und Beispielen werden keine 
Eigenschaften zugesichert. Die abgebildeten Zeichnungen, Darstellungen und Beispiele enthalten 
weder Systemverantwortung noch applikationsspezifische Besonderheiten. 

Die Sicherheit der Maschine/Anlage muss auf jeden Fall eigenverantwortlich durch den Hersteller der 
Maschine/Anlage gewährleistet werden. 

 

 WARNUNG 
Sach- oder Körperschäden möglich bei Nichtbeachten der Hinweise in dieser Anleitung!  
Die ifm electronic gmbh übernimmt hierfür keine Haftung. 

► Die handelnde Person muss vor allen Arbeiten an und mit diesem Gerät die Sicherheitshinweise 
und die betreffenden Kapitel dieser Anleitung gelesen und verstanden haben. 

► Die handelnde Person muss zu Arbeiten an der Maschine/Anlage autorisiert sein. 

► Beachten Sie die Technischen Daten der betroffenen Geräte! 
Das aktuelle Datenblatt finden Sie auf der ifm-Homepage:  
 www.ifm.com > Land wählen > [Datenblattsuche] > (Artikel-Nr.) > [Technische Daten im PDF-
Format] 

► Beachten Sie die Montage- und Anschlussbedingungen sowie die bestimmungsgemäße 
Verwendung der betroffenen Geräte!  
 mitgelieferte Montageanleitung oder auf der ifm-Homepage:  
 www.ifm.com > Land wählen > [Datenblattsuche] > (Artikel-Nr.) > [Betriebsanleitungen] 

 

Anlaufverhalten der Steuerung 

Der Hersteller der Maschine/Anlage muss mit seinem Applikations-Programm gewährleisten, dass 
beim Anlauf oder Wiederanlauf der Steuerung keine gefahrbringenden Bewegungen gestartet werden 
können. 

Ein Wiederanlauf kann z.B. verursacht werden durch: 

 Spannungswiederkehr nach Spannungsausfall 

 Reset nach Watchdog-Ansprechen wegen zu langer Zykluszeit 
 

http://www.ifm.com/�
http://www.ifm.com/�
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Sicherheitshinweise Welche Vorkenntnisse sind notwendig? 

 

2.2 Welche Vorkenntnisse sind notwendig? 
215 

Das Dokument richtet sich an Personen, die über Kenntnisse der Steuerungstechnik und SPS-
Programmierkenntnisse mit IEC 61131-3 verfügen. 

Wenn dieses Gerät über eine SPS verfügt, sollten die Personen zusätzlich mit der Software CoDeSys 
vertraut sein. 

Das Dokument richtet sich an Fachkräfte. Dabei handelt es sich um Personen, die aufgrund ihrer 
einschlägigen Ausbildung und ihrer Erfahrung befähigt sind, Risiken zu erkennen und mögliche 
Gefährdungen zu vermeiden, die der Betrieb oder die Instandhaltung eines Produkts verursachen 
kann. Das Dokument enthält Angaben zum korrekten Umgang mit dem Produkt. 

Lesen Sie dieses Dokument vor dem Einsatz, damit Sie mit Einsatzbedingungen, Installation und 
Betrieb vertraut werden. Bewahren Sie das Dokument während der gesamten Einsatzdauer des 
Gerätes auf.  

Befolgen Sie die Sicherheitshinweise. 
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Systembeschreibung Welche Vorkenntnisse sind notwendig? 

3 Systembeschreibung 
6122 

Dieses Dokument beschreibt das Software-Tool "Downloader 32" der ifm electronc gmbh. 

Der Downloader bietet folgende Funktionen: 

 Bootlader, Betriebssystem (Laufzeitsystem), Applikations-Programm oder Datenlisten und 
Meldetexte in Steuerung oder E/A-Module (nur ifm-Geräte) schreiben. 
Vorgeschriebene Formate: 
 - Bootlader: H86-Datei 
 - Betriebssystem: H86-Datei 
 - Applikations-Programm: H86-Datei oder PRG-Datei 
 - Daten- / Meldetext-Listen: H86-Datei oder CLV-Datei 

 Applikations-Programm (H86-Datei) aus einer Steuerung lesen und als 1:1-Kopie in weitere 
Steuerungen schreiben (zwecks Serienfertigung). Für Sicherheitsanwendungen ist dies die 
einzige zulässige Methode, zertifizierte Programme zu duplizieren. 

 Setzen und Prüfen der Prüfsumme CRC (für Sicherheitsanwendungen). 

 Parameterdateien (z.B. Texte oder Werte in CSV-Dateien) schreiben und lesen. 

 Anzeigen des aktuell gespeicherten Laufzeitsystems und Applikations-Programms. 

 Anzeigen aktueller Speicherbelegungen (sogenanntes Hex-Dump). 

 Starten und Anhalten des Applikations-Programms im Gerät. 

 Das Tool ist batch-fähig. Somit können Auftragslisten als TXT-Datei erstellt werden, die mit nur 
1 Mausklick mehrere Downloader-Kommandos in Folge abarbeiten. 
 Befehlszeilen programmieren (→ Seite 37) 

 Als Schnittstellen werden unterstützt: 
 - serielle Schnittstelle RS232 
 - USB-Schnittstelle 
 - CAN-Schnittstelle (nur CAN-Adapter mit VCI-Schnittstelle möglich) 
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Schnittstellen konfigurieren Schnittstelle auf dem PC einrichten 

4 Schnittstellen konfigurieren 
enthält: 

Schnittstelle auf dem PC einrichten .............................................................................................10 
Gültigen COM-Port ermitteln........................................................................................................10 
CANview-Treiber installieren und konfigurieren...........................................................................11 

6203 

Bevor der Downloader sinnvoll eingesetzt werden kann, muss der Anwender die zu verwendenden 
Schnittstellen auf dem PC eingerichtet und die Treiber richtig konfiguriert haben. 
 

 

4.1 Schnittstelle auf dem PC einrichten 
6148 

Wenn die USB- oder CANview-Schnittstelle erstmalig an diesem PC für ifm-Geräte verwendet wird, 
dann Schnittstelle einrichten (Administrator-Rechter erforderlich!): 

> Fenster [Neue Hardware gefunden] erscheint. 

► Fenster mit Frage "Soll Windows zu Windows Update verbinden?" erscheint. 

► Optionsfeld [Nein, diesmal nicht] aktivieren. 
Mit [Weiter] zum nächsten Fenster schalten. 

► ecomatmobile-DVD "Software, tools and documentation" in das DVD-Laufwerk des PCs 
einlegen. 

► Optionsfeld [Software automatisch installieren] aktivieren. 
Mit [Weiter] zum nächsten Fenster schalten. 

> Installations-Assistent sucht auf der DVD nach dem passenden Treiber für die Schnittstelle. 

> Warnmeldung erscheint, dass die Treiber-Software den Windows-Logo-Test nicht bestanden hat. 

► Mit [Trotzdem fortsetzen] die Installation fortsetzen. 

► Installations-Assistent installiert den Treiber. 

> Meldung "Treiber-Software ist fertig installiert" erscheint. 

► Mit [Fertigstellen] zum nächsten Fenster schalten. 

Der gleiche Vorgang wiederholt sich nun für die Port-Installation. 

> Die Schnittstelle ist nun bereit zum Betrieb mit dem angeschlossenen Gerät. 
 

 

4.2 Gültigen COM-Port ermitteln 
6205 

► Unter Windows die Systemsteuerung starten. 

► Wählen: [System] > [Hardware] > [Geräte-Manager]. 

► Den Zweig [Anschlüsse (COM und LPT)] öffnen. 

► Hinter dem installierten Treiber (z.B. ifm CANview-USB) steht der zugehörige COM-Port, z.B. 
COM6. 
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Schnittstellen konfigurieren CANview-Treiber installieren und konfigurieren 

 

4.3 CANview-Treiber installieren und konfigurieren 
6159 

ifm-CANview ist eine VCI-Emulation des Treibers IXXAT. 

► Zum Installieren des CAN-Modem-Treibers darf der Downloader nicht aktiv sein. 

► CANview-Modem am PC anschließen. 

► CAN-Modem-Treiber auf dem PC installieren ( Bedienungsanleitung des Modems). 
Für ifm-CANview die ecomatmobile-DVD "Software, tools and documentation" in das DVD-
Laufwerk legen. 
HINWEIS: Zur Installation sind Administrator-Rechte erforderlich! 

► Den passenden Modem-Treiber wählen: 

 
ifm CAN Config für CANview an der USB-Schnittstelle 

 
ifm CAN Config für CANview an der seriellen Schnittstelle 

► Das zum Modem gehörende CANview 
wählen: 
EC2071 = USB  [CANview USB] 
und zwar... 
a) oben den entsprechenden Reiter (TAB) 
b) unten als [ifm CAN device used for 
communication]. 

► Den in der Windows-Systemsteuerung 
ermittelten COM-Port wählen. 

► Das zum Modem gehörende CANview 
wählen: 
EC2070 = seriell  [CANview] 
und zwar... 
a) oben den entsprechenden Reiter (TAB) 
b) unten als [ifm CAN device used for 
communication]. 

► Den in der Windows-Systemsteuerung 
ermittelten COM-Port wählen (meist: COM1). 

► Zum Gerät passende Baudrate wählen 
( Datenblatt). 

► [Transmit Time Stamp] aktivieren. 

> Ergebnis  Bild oben. 

► Mit [Write INI File] die bisherigen Einstellungen für die Schnittstelle speichern. 
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Schnittstellen konfigurieren CANview-Treiber installieren und konfigurieren 

► Mit [Settings] > [VCI] die VCI-Einstellungen des Treibers 
öffnen ( Bild rechts): 

► [Use ifm-VCI-Emulation] wählen. 

► Je nach Schnittstelle: Im Feld [VCI ID CANview] oder [VCI 
ID CANview USB] den gewünschten Treiber *) einstellen. 

*) Für jede Schnittstelle muss ein anderer Treiber angegeben 
sein. 

*) Die im Downloader angegebene [CAN Board Type] muss mit 
dem in den VCI-Einstellungen für die betreffende Schnittstelle 
angegebenen [VCI ID CANview]-Treiber übereinstimmen. 

► Fenster [VCI-Settings] mit [Close] schließen. 

 
Die von ifm empfohlenen VCI-Einstellungen 

► Mit [Write INI File] die Einstellungen für die Schnittstelle speichern. 

► Mit [Load Standard Config. Systerm 2] die Einstellung in das CANview-Modul laden 
(gegebenenfalls überschreiben). 

► Ein Fortschrittsbalken in der Statuszeile zeigt den Ablauf der Datenübertragung. 

► Den Modem-Konfigurator mit [File] > [Exit] oder mit [Alt] + [F4] schließen. 
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Menüs Menü [File] 

5 Menüs 
enthält: 

Menü [File]....................................................................................................................................13 
Menü [Interface] ...........................................................................................................................17 
Menü [Protocol] ............................................................................................................................22 
Menü [Security] ............................................................................................................................23 
Menü [Options] .............................................................................................................................24 
Menü [Specials]............................................................................................................................30 
Menü [?] .......................................................................................................................................35 
Schaltflächen................................................................................................................................36 

6124 

 
Bild: Menüleiste 

 

 

5.1 Menü [File] 
6126 

 

Bild: Übersicht des Menüs [File] 

Das Menü öffnet... 
 - mit Maus-Klick auf [File] 
 - mit der Tastenkombination [Alt]+[F] 

 

Menü Beschreibung 

[File] > [Load Configuration] Lädt eine vorhandene Konfiguration 

> Windows-Explorer öffnet Fenster [Öffnen]. 

► Laufwerk, Verzeichnis und CFG-Datei wählen. 

► Mit [Öffnen] gewählte Konfiguration laden. 

HINWEIS: Beim Starten des Downloaders wird automatisch 
die zuletzt gespeicherte Konfiguration Download.cfg 
geladen. 

[File] > [Save Configuration] Speichert die aktuelle Konfiguration 

> Windows-Explorer öffnet Fenster [Speichern unter]. 

► Laufwerk und Verzeichnis wählen. 

► Dateinamen (.CFG) eintragen. 

► Mit [Speichern] Konfiguration speichern. 

HINWEIS: Beim Beenden des Downloaders wird automatisch 
im Verzeichnis der Download.exe die aktuelle Konfiguration 
als Download.cfg gespeichert. 
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Menüs Menü [File] 

Menü Beschreibung 

[File] > [File System] (ab Target V05)  
Hier können z.B. Symbol-Dateien abgelegt werden. 

Öffnet Fenster [File System] (→ Seite 15). 

[File] > [Test Checksum] Vergleicht die Prüfsumme CRC des Applikations-Programms 
im PC mit der Prüfsumme des Applikations-Programms in 
der Steuerung. Die Prüfsumme muss der Datei mit [Add 
Checksum] hinzugefügt worden sein. 

[File] > [Add Checksum] Fügt dem Applikations-Programm auf der PC-Festplatte eine 
Prüfsumme zu oder aktualisiert die vorhandene Prüfsumme. 
Der Steuerungstyp legt die Länge der Prüfsumme fest (2 
oder 4 Bytes). 

[File] > [Bin to H86] Konvertiert eine BIN-Datei (Applikations-Programm im PC) 
in eine H86-Datei. Das Format H86 ist eine ASCII-lesbare 
Darstellung einer Binärdatei. 

CoDeSys ab V2.3 erzeugt auf Anforderung BIN-Dateien. 
Um Applikations-Programme (wie bis V2.1) ohne Einsatz 
eines Programmiersystems (aber mit dem Downloader) in die 
Steuerung schreiben zu können, muss das Applikations-
Programm mit diesem Kommando konvertiert werden. 

Für die Controller CRnn32 erzeugt CoDeSys beim 
[Bootprojekt erzeugen] automatisch eine PRG-Datei, die der 
Downloader zum Downloaden verwenden kann. 

[File] > [Exit] Beendet den Downloader. 

Alternativ: [Alt]+[F4]  
oder Mausklick auf  
oder Mausklick auf [Exit]. 
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Menüs Menü [File] 

 

5.1.1 Fenster [File System] 
6223 

Der Benutzer speichert im Gerät einzelne Dateien unter vorgegebenem Namen. Unter diesen Namen 
sind die Dateien abrufbar (für CoDeSys und Downloader). 

Datei-Typen: beliebig. Die Dateien sind anwendungsspezifisch, z.B. Symbol-Datei. In der Steuerung 
wird die Symbol-Datei aus CoDeSys gespeichert. Ein Diagnosesystem kann das Symbol laden, um 
die Adressen von Variablen zu erhalten und dann per 3S-Kommunikation die Werte der Variablenaus 
der Steuerung zu lesen. Von der Steuerung aus kann auf die Dateiablage nicht zugegriffen werden. 

Ist die Datei größer als der Ablageplatz oder ist der Ablageplatz bereits voll, wird eine Fehlermeldung 
ausgegeben. Bei jedem Applikations-Download werden alle diese Dateien im Dateisystem gelöscht. 

Das Ändern von Dateien ist nicht möglich.  
Das Löschen einzelner Dateien ist nicht möglich. 
Nur das gesamte Löschen des Dateisystems ist möglich. 

► Im Downloader-Menü [File] > [File System] klicken. 

> Das Fenster [File System] öffnet sich (hier: 
Voreinstellung): 

> Das Bild zeigt ein leeres Dateisystem. Wenn sich 
Dateien im Dateisystem befinden, werden diese 
angezeigt. 

> Neue Dateien werden (auch bei gleichem 
Namen) hinten angefügt. 

 
 

Folgende Einstellungen sind möglich: 

Feld Beschreibung 

Size Für CR0020, CR0200, CR0505, CR7nnn, BU0020, CR9025: 
Größe des Dateisystems = 128 kB, 
max. einzelne Dateigröße 64 kB. 

Für CC0241, CR03nn, CR1070, CR1071, CR25nn, CS0015: 
Größe des Dateisystems = 64 kB, 
max. einzelne Dateigröße 64 kB. 

Für CRnn32: 
Größe des Dateisystems = 128 kB, 
max. einzelne Dateigröße 128 kB. 

Name Alles wird in Kleinbuchstaben gewandelt. 

Nur ASCII-Standard-Zeichen zulässig (auch Leerzeichen). 

16-Bit-Systeme: Namenslänge max. 24 Zeichen 
32-Bit-Systeme: Namenslänge max. 256 Zeichen 
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Menüs Menü [File] 

 

Schaltfläche Beschreibung 

Download einzelne Dateien in das Gerät schreiben: 

> Windows-Explorer [Datei öffnen] öffnet. 

► Verzeichnis und Datei wählen. 

► Mit [Öffnen] gewählte Datei in das Dateisystem des Geräts 
übertragen. 

> Dateiname erscheint mit seiner Größe im Fenster [File System] an 
letzter Position. 

► Vorgang bei Bedarf mit weiteren Dateien wiederholen. 

Upload die im Dateisystem stehenden Dateien in den PC kopieren: 

> Windows-Explorer [Speichern unter] öffnet. 

► Zielverzeichnis wählen und gewünschten Dateinamen eintragen. 

► Mit [Speichern] kopiert der Downloader die Datei auf die Festplatte 
des PCs. 

Erase All alle Einträge in dieser Liste löschen 

> Alle Dateien im Gerät werden gelöscht. 

Close dieses Fenster schließen 
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Menüs Menü [Interface] 

 

5.2 Menü [Interface] 
6127 

Aktiviert die Verbindung des Downloader zum Gerät über eine bestimmte Schnittstelle. 

► Gerät an der vorgesehenen Schnittstelle anschließen. 

► Wenn diese Schnittstelle (USB, CAN) erstmalig an diesem PC für ifm-Geräte verwendet wird, 
dann vor den weiteren Schritten die Schnittstelle einrichten (→ Seite 10). 

 

 

Bild: Übersicht des Menüs [Interface] 

Das Menü öffnet... 
 - mit Maus-Klick auf [Interface] 
 - mit der Tastenkombination [Alt]+[I] 

 

Menü Beschreibung 

[Interface] > [RS232] Verbindung über die serielle Schnittstelle (Voreinstellung). 

Öffnet das Fenster [RS232] (→ Seite 18) zur Konfiguration 
der seriellen Schnittstelle. 

[Interface] > [USB] Verbindung über die USB-Schnittstelle. 

Öffnet das Fenster [USB] (→ Seite 19) zur Konfiguration der 
USB-Schnittstelle. 

[Interface] > [CAN] Verbindung über die CAN-Schnittstelle. 

Öffnet das Fenster [CAN] (→ Seite 20) zur Konfiguration der 
CAN-Schnittstelle. 

► Nach einem Wechsel der Schnittstelle [Identity] klicken. 

> Downloader liest die Daten des an der aktuellen Schnittstelle angeschlossenen Geräts und zeigt 
sie in einem neuen Fenster. Beispiele: 

 

> Anzeige Version des Bootladers. 

> Anzeige Geräte-Daten. 

> Anzeige Status: SPS-Programm läuft nicht: 
(Ist ja auch noch nicht installiert). 

 

> Anzeige Version des Betriebssytems. 

> Anzeige Geräte-Daten. 

> Anzeige Status: SPS-Programm läuft. 

> Anzeige Zykluszeit des SPS-Programms. 

► Mit [OK] das Fenster schließen. 
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5.2.1 Fenster [RS232] 
6144 

► Im Downloader-Menü [Interface] > [RS232] klicken. 

> Das Fenster [RS232] öffnet sich, z.B.: 

 

Folgende Einstellungen sind möglich: 

Feld Beschreibung 

Bits per Second Baudrate [Bits je Sekunde]. 
Mögliche Werte = 9600, 19200, 28800, 38400, 57600, 115200. 

Data Bits Anzahl Datenbits. 
Mögliche Werte = 7, 8. 

Parity Parität: 
N = keine Parität 
E = gerade Parität 
O = ungerade Parität 

Stop Bits Anzahl Stopp-Bits. 
Mögliche Werte = 1, 2 

COM-Port Auswahl des COM-Ports am PC. 
(Abhängig von Gerät und Betriebssystem-Konfiguration) 

► Mit [OK] Werte übernehmen und Fenster schließen. 

ODER: 

► Mit [Cancel] Fenster schließen. 

> Werte bleiben unverändert. 
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5.2.2 Fenster [USB] 
6146 

► Im Downloader-Menü [Interface] > [USB] klicken. 

> Das Fenster [USB] öffnet sich (hier: Voreinstellung): 

 

Folgende Einstellungen sind möglich: 

Feld Beschreibung 

COM-Port Auswahl des COM-Ports am PC. 
(Abhängig von Gerät und Betriebssystem-Konfiguration) 

► Mit [OK] Werte übernehmen und Fenster schließen. 

ODER: 

► Mit [Cancel] Fenster schließen. 

> Werte bleiben unverändert. 
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5.2.3 Fenster [CAN] 
6149 

► Im Downloader-Menü [Interface] > [CAN] klicken. 

> Das Fenster [CAN] öffnet sich, z.B.: 

 
 

Folgende Einstellungen sind möglich: 

Feld Beschreibung 

Baudrate KBit/s Anzahl Bits je Sekunde. 
Mögliche Werte = 10, 20, 50, 100, 125, 250, 500, 800, 1000. 

► Mit [Set PLC] gewählten Wert in die Steuerung schreiben *). 

Download-ID ► Mit [Scan] in den Bereichen [From]...[To] nach passendem 
Download-ID suchen. Standardwert für ifm-Steuerungen ist 127. 

> Anzeige gefundener Wert (hier: 32). 

ODER: 

► Angezeigten Wert mit gewünschtem Wert überschreiben. 

► Mit [Set PLC] gewählten Wert in die Steuerung schreiben *). 

Address Interrupt [Hex] = Wert wird bei der Installation des Treibers 
zugewiesen. NICHT verändern! 

Base [Hex] = 0 (NICHT verändern!) 

CAN Board Type Auswahl des angeschlossenen CAN-Modems **) 
 Gerätebeschreibung des Herstellers 
 CANview-Treiber installieren (→ Seite 11) 

*) Wert kann nur bei funktionierender Kommunikation in die Steuerung geschrieben werden. 

**) Die im Downloader angegebene [CAN Board Type] muss mit dem in den VCI-Einstellungen für die 
betreffende Schnittstelle angegebenen [VCI ID CANview]-Treiber übereinstimmen. 

 

 HINWEIS 
Der CAN-Download-ID des Geräts muss mit dem in CoDeSys eingestellten CAN-Download-ID 
übereinstimmen! 

Im CAN-Netzwerk müssen die CAN-Download-IDs einmalig sein! 
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 HINWEIS 
Der im Downloader angegebene CAN-Modem-Treiber muss identisch sein mit dem beim Installieren 
angegebenen Treiber. 

 

► Mit [OK] Werte übernehmen und Fenster schließen. 

ODER: 

► Mit [Cancel] Fenster schließen. 

> Werte bleiben unverändert. 
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5.3 Menü [Protocol] 
6128 

Die Auswahl bestimmt, wie (mit welchem Protokoll) der Downloader mit dem Gerät kommunizieren 
soll. 
 

 

Bild: Übersicht des Menüs [Protocol] 

Das Menü öffnet... 
 - mit Maus-Klick auf [Protocol] 
 - mit der Tastenkombination [Alt]+[I] 

 

Menü Beschreibung 

[Protocol] > [Ecoplus Vx2.1] Kommunikation über Ecoplus V2.1 

Dies ist der Vorläufer von CoDeSys V2.3. 

[Protocol] > [CoDeSys V2.3 C167] Kommunikation über CoDeSys V2.3 C167 (Voreinstellung) 

Dies gilt für die folgenden Geräte: 
 - CabinetController: CR030n  
 - ClassicController: CR0020, CR0505 (RTS < V05) 
 - ExtendedController: CR0200 (RTS < V05) 
 - Platinensteuerung: CS0015 
 - SafetyController: CR7020, CR7200, CR7505 (RTS < V05) 
 - SmartController: CR25nn 
 - PDM360smart: CR1070, CR1071  

[Protocol] > [CoDeSys V2.3 Tricore] Kommunikation über CoDeSys V2.3 Tricore 

Dies gilt für die folgenden Geräte: 
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 

[Protocol] > [Bootstrap] *) Bootstrap lädt den Bootloader (die Firmware) in das Gerät. 

Der Lademodus muss vom Anwender forciert werden. 

[Protocol] > [Bootstrap (Auto)] Wie vorstehend, jedoch für folgende Geräte:  
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 

Der Lademodus wird automatisch aktiviert. 

*) ACHTUNG: Die gestartete Datenübertragung darf nicht unterbrochen werden. Falls die 
Datenübertragung vor ihrem Abschluss unterbrochen wird, ist das Gerät nicht mehr einsatzfähig und 
muss zur Reparatur an den Kundenservice eingeschickt werden. 
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5.4 Menü [Security] 
6129 

Sicherheitseinstellung, ob die Datenübertragung sicher oder unsicher erfolgen soll, also mit oder ohne 
Prüfsummenbildung CRC. 

 

Bild: Übersicht des Menüs [Security] 

Das Menü öffnet... 
 - mit Maus-Klick auf [Security] 
 - mit der Tastenkombination [Alt]+[S] 

 

Menü Beschreibung 

[Security] > [With CRC] Datenübertragung mit Prüfsummenbildung 
(Voreinstellung, obligatorisch für Sicherheitsanwendungen) 

[Security] > [No CRC] Datenübertragung ohne Prüfsummenbildung 
(vorwiegend für Dateien, bei denen die Prüfsummenbildung 
nicht möglich ist) 
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5.5 Menü [Options] 
6130 

Bietet detaillierte Einstellmöglichkeiten. 
 

 

Bild: Übersicht des Menüs [Options] 

Das Menü öffnet... 
 - mit Maus-Klick auf [Options] 
 - mit der Tastenkombination [Alt]+[IO] 

 

Menü Beschreibung 

[Options] > [File Options] Öffnet neues Fenster [File Options] (→ Seite 25) 

[Options] > [Memory Settings] Öffnet neues Fenster [Memory Settings] (→ Seite 27) 

[Options] > [Password] Öffnet neues Fenster [Password] (→ Seite 29) 

[Options] > [Ask before Download] aktiviert: Vor Ausführen des angeforderten Downloads erfolgt 
eine Sicherheitsabfrage, die mit [Ja] bestätigt werden muss. 

deaktiviert: Der angeforderte Download erfolgt sofort, ohne 
Sicherheitsabfrage. 

[Options] > [Tool Tips] aktiviert: Zeigt eine Kurzbeschreibung der zugehörigen 
Funktion, wenn der Mauszeiger über eine Schaltfläche 
gehalten wird. 

deaktiviert: Zeigt keine Kurzbeschreibung der zugehörigen 
Funktion, wenn der Mauszeiger über eine Schaltfläche 
gehalten wird. 

[Options] > [Welcome / Good Bye] aktiviert: Zeigt beim Start des Downloaders das Versions-
Fenster und beim Beenden das ifm-Fenster jeweils für 
1 Sekunde. 

deaktiviert: Startet und beendet den Downloader ohne diese 
Fenster. 
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5.5.1 Fenster [File Options] 
6135 

Die [File Options] geben Speicherbereiche für den Upload oder Download an. Diese Speicherbereiche 
werden vom Downloader als die zu verwendenden Bestandteile der H86-Datei betrachtet. Die 
Adressen und Größen dieser Speicherbereiche geben Sie im Fenster [Memory Settings] (→ Seite 27) 
an. 

Beispiel: Zum Lesen aus dem Gerät (= Upload) 3 Speicherbereiche wählen. Diese Speicherbereiche 
werden beim Upload in 1 gemeinsame H86-Datei geschrieben. Vor dem Download dieser H86-
Datei in ein anderes Gerät in den [File Options] z.B. nur noch 1 Bereich oder 2 Bereiche davon oder 
auch alle 3 wählen, um nur diese Bereiche in das andere Gerät zu schreiben. 

 

 HINWEIS 
Das Laufzeitsystem darf nicht mit anderen Optionen kombiniert werden. 

Das Applikations-Programm kann mit einem oder mehreren anderen Optionen kombiniert werden. 

Beim Schreiben in die SPS (= Download) nicht mehrere Optionen zusammen in eine Datei 
schreiben, sonst können beim späteren Upload Probleme auftreten. 

 

► Im Downloader-Menü [Options] > [File Options] klicken. 

> Das Fenster [File Options] öffnet sich (hier: Voreinstellung): 

 
 

Folgende Einstellungen sind möglich: 

Option Beschreibung 

Runtime System  
/ Application Program 

Definiert die H86-Datei als Laufzeitsystem oder als Applikations-
Programm. 

Beim Schreiben erkennt der Downloader automatisch den gewählten 
Dateityp. 
Beim Lesen ist nur das Applikations-Programm (mit oder ohne weitere 
Optionen kombiniert) möglich. 
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Option Beschreibung 

Memory Retains Für folgende Geräte verfügbar:  
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 
 - Geräte mit Laufzeitsystem V2.1 

Memory Retains = Retains im Memory-Bereich 
Speicher spannungsausfallgeschützt, adress-orientiert 

Ermöglicht den Upload oder Download der Memory Retains. 

Var Retains Variablen spannungsausfallgeschützt, variablen-orientiert 

File Flash Für folgende Geräte verfügbar:  
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 

Ermöglicht den Upload oder Download des kompletten Dateisystems. 

User Flash Bereich für Daten des Applikations-Programms, z.B.: 
 - Meldetexte im PDM 
 - Datentabellen 

Data Flash Bereich für FLASH_READ und FLASH_WRITE 

EEPROM / FRAM Data Daten im EEPROM / FRAM 

CSV Auswahl des Trennzeichens in Datentabellen: 

CSV = ";" (USA): 
  CR/LF = ";" 
  Spaltentrennung = "," 

CSV = "," (Europa): 
  CR/LF = "," 
  Spaltentrennung = ";" 
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5.5.2 Fenster [Memory Settings] 
6136 

Das Menü dient dem Anzeigen und Einstellen der Speicherbereiche im Gerät. In der Regel sind für 
den Kunden hier keine Änderungen sinnvoll. 

HINWEIS: Beachten Sie die Speichertabellen in der Systembeschreibung des betreffenden Geräts! 
 

 

ACHTUNG 
Gefahr von Datenverlust und von Fehlfunktionen bei falschen Einstellungen. 

► Angezeigte Werte nur mit größter Vorsicht und Sachkenntnis ändern! 

 

► Im Downloader-Menü [Options] > [Memory Settings] klicken. 

> Das Fenster [Memory Settings] öffnet sich (Beispiel für CR0032): 

 
Base = Startadresse [Byte] 
Size = Speichergröße [Bytes] 

 

Folgende Einstellungen sind möglich: 

Menü Beschreibung 

Bootloader Speicherbereich für den Bootloader 

Runtime System Speicherbereich für das Laufzeitsystem 

User Program Speicherbereich für das Applikations-Programm 

File Flash Für folgende Geräte verfügbar:  
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 

Speicherbereich für das komplette Dateisystem 
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Menü Beschreibung 

User Flash Speicherbereich für Daten des Applikations-Programms, z.B.: 
 - Meldetexte im PDM, 
 - Datentabellen 
 - Symbolnamenslisten für Variable 

Data Flash Speicherbereich für FLASH_READ und FLASH_WRITE 

RAM Speicherbereich für den flüchtigen Speicher 

Application Data Speicherbereich für die Anwendungsdaten 

Memory Speicherbereich für die IEC-Merkeradressen %Mxyz 

Memory Retain Data Für folgende Geräte verfügbar:  
 - ClassicController: CR0020, CR0505 (RTS > V05) 
 - ExtendedController: CR0200 (RTS > V05) 
 - Controller: CRnn32 
 - SafetyController: CR7020, CR7200, CR7505 (RTS > V05) 
 - SafetyController: CR7021, CR7201, CR7506 
 - Geräte mit Laufzeitsystem V2.1 

Memory Retains = Retains im Memory-Bereich 
Speicherbereich spannungsausfallgeschützt, adress-orientiert 

Var Retain Data Speicherbereich für Variablen spannungsausfallgeschützt, variablen-
orientiert 

EEPROM / FRAM Data Speichergröße für Daten im EEPROM oder FRAM 

 

Schaltfläche Beschreibung 

Read Settings die aktuelle Speicherbelegung aus dem Gerät lesen und die Anzeige 
aktualisieren 

Disable Reading aktiviert = Kein Lesen der Speichertabelle vom Gerät möglich 

deaktiviert = Speichertabelle kann mit [Read Settings] vom Gerät 
gelesen werden. Die Anzeige wird entsprechend aktualisiert. 

Apply Changes die hier geänderten Werte speichern 

Close dieses Fenster schließen 
INFO: Wenn Änderungen noch nicht gespeichert sind, erscheint eine 
Sicherheitsabfrage. 
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5.5.3 Fenster [Password] 
6138 

Das Applikations-Programm kann mit SET_PASSWORD gegen unbefugten Zugriff geschützt werden. 
Dieses Passwort muss auch im Downloader genannt werden, um das Programm aus dem Gerät lesen 
und duplizieren zu können: 

► Im Downloader-Menü [Options] > [Password] klicken. 

> Das Fenster [Password] öffnet sich: 

 

► Passwort eintragen. 

> Das Applikations-Programm kann aus dem Gerät gelesen und dupliziert werden. 

► Kontrollfeld [Store Password] aktivieren zum Speichern des Passworts. 

> Das Passwort wird bis zur nächsten Änderung dauerhaft gespeichert, um nicht bei jedem Zugriff 
auf das Programm das Passwort erneut eingeben zu müssen. 
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5.6 Menü [Specials] 
6131 

 

Bild: Übersicht des Menüs [Specials] 

Das Menü öffnet... 
 - mit Maus-Klick auf [Specials] 

 

Menü Beschreibung 

[Specials] > [Commands] Erweitert das Menü um eine Ebene 
( Erweitertes Menü [Commands] (→ Seite 32)): 
 - Boot Commands 
 - Goto Bootloader 
 - Goto Bootstrap Loader 

[Specials] > [PLC Information] > Öffnet ein neues Fenster [PLC Information] mit aktuellen 
SPS-Informationen des Geräts. (Beispiel  unten) 

► Fenster mit [Close] schließen. 

[Specials] > [System Statistic] Nur bei folgenden Geräten: Controller CRnn32 

> Liest die Statistik-Daten aus dem Gerät. 
Die erzeugte Datei Statistic.LG enthält den Inhalt 
des Fehlerspeichers der Steuerung. 

► Wenn die Datei Statistic.LG bereits im Downloader-
Verzeichnis existiert, mit [Ja] die Anfrage bestätigen, ob 
die Datei überschrieben werden darf. 

[Specials] > [Memory] > Öffnet ein neues Fenster [Memory] (→ Seite 34) mit dem 
aktuellen Speicherabbild des Geräts. 

► Fenster mit [Close] schließen. 

[Specials] > [About] > Öffnet ein neues Fenster mit den Programm-
Informationen des Downloaders. 

► Fenster mit [Close] schließen. 
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Beispiel für das Fenster [PLC Information]: 
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5.6.1 Erweitertes Menü [Commands] 
6193 

 
 

[Specials] > [Commands] > [Boot Commands] 

> Weitere Untermenüs möglich: 
 - Goto Bootloader with Factory Settings 
 - Goto Bootloader 
 - Goto Runtime System, Erase Application 

 

[Specials] > [Commands] > [Boot Commands] > [Goto Bootloader with Factory Settings] 

> Anzeige Aufforderung zum Aus- und wieder Einschalten des Geräts. 

► Spannungsversorgung des Geräts aus- und wieder einschalten. 

> Wenn der Downloader mit den aktuellen Einstellungen das Gerät nicht findet, durchsucht er alle 
definierten Schnittstellen und Protokolle. 

> Gerät werden das Betriebssystem und die Applikation gelöscht. 

> Im Gerät werden die Werkseinstellungen gesetzt. 
 

[Specials] > [Commands] > [Boot Commands] > [Goto Bootloader] 

> Anzeige Aufforderung zum Aus- und wieder Einschalten des Geräts. 

► Spannungsversorgung des Geräts aus- und wieder einschalten. 

> Wenn der Downloader mit den aktuellen Einstellungen das Gerät nicht findet, durchsucht er alle 
definierten Schnittstellen und Protokolle. 

> Im Gerät werden das Betriebssystem und die Applikation gelöscht. 

> Die Einstellungen im Gerät bleiben erhalten. 
 

[Specials] > [Commands] > [Boot Commands] > [Goto Runtime System, Erase Application] 

> Anzeige Aufforderung zum Aus- und wieder Einschalten des Geräts. 

► Spannungsversorgung des Geräts aus- und wieder einschalten. 

> Wenn der Downloader mit den aktuellen Einstellungen das Gerät nicht findet, durchsucht er alle 
definierten Schnittstellen und Protokolle. 

> Im Gerät wird die Applikation gelöscht. 
 

[Specials] > [Commands] > [Goto Bootloader] 

WICHTIG: Der Downloader berücksichtigt die Einstellungen für Schnittstelle und Protokoll. Wenn der 
Downloader das Gerät hierbei nicht findet, erscheint eine Fehlermeldung und das Kommando wird 
nicht ausgeführt. 

> Im Gerät werden das Betriebssystem und die Applikation gelöscht. 

> Die Einstellungen im Gerät bleiben erhalten. 
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[Specials] > [Commands] > [Goto Runtime System] 

(Nur bei folgenden Geräten: Controller CRnn32) 

> Anzeige Aufforderung zum Aus- und wieder Einschalten des Geräts. 

► Spannungsversorgung des Geräts aus- und wieder einschalten. 

> Wenn der Downloader mit den aktuellen Einstellungen das Gerät nicht findet, durchsucht er alle 
definierten Schnittstellen und Protokolle. 

> Im Gerät wird die Applikation gelöscht. 
 

[Specials] > [Commands] > [Goto Bootstrap Loader] 

(Nicht bei folgenden Geräten: Controller CRnn32) 

ACHTUNG: Nach diesem Kommando ist das Gerät nicht mehr vom Anwender programmierbar und 
muss dem ifm-Kundendienst gesendet werden. 

> Anzeige Aufforderung zum Aus- und wieder Einschalten des Geräts. 

► Spannungsversorgung des Geräts aus- und wieder einschalten. 

> Wenn der Downloader mit den aktuellen Einstellungen das Gerät nicht findet, durchsucht er alle 
definierten Schnittstellen und Protokolle. 

> Im Gerät werden der Bootloader, das Betriebssystem und die Applikation gelöscht. 
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5.6.2 Fenster [Memory] 
6195 

Mit Menü [Specials] > [Memory] öffnet ein neues Fenster mit dem Speicherabbild des Geräts, z.B.: 

 

Folgende Einstellungen sind möglich: 

Menü Beschreibung 

Memory Map ► Wahl des anzuzeigenden Speicherbereichs: 

 

View Settings ► Wahl der Werte-Darstellung: 

 

Copy to Clipboard > Kopiert den Fensterinhalt in die Windows-Zwischenablage 

► Inhalt in eine ASCII-Datei (z.B. .TXT) kopieren. 

Die Einträge können in der Datei bearbeitet und verändert werden. 
 

Feld Beschreibung 

Address ► Mit [+] oder [-] im Speicherabbild um 100 Bytes nach oben oder 
unten blättern. 

► Nach Eintrag einer Speicheradresse mit [OK] diesen Wert als 
neue  Startadresse in der Anzeige übernehmen. 

Type > Anzeige aktueller Speicherbereich-Name. 

Status > Anzeige, ob Speicherabbild gelesen oder geschrieben wird. 

► Mit [Close] das Fenster schließen. 
 



 

35 

ifm Programmhandbuch ecomatmobile Downloader 32 

Menüs Menü [?] 

 

5.7 Menü [?] 
6132 

 Das Menü öffnet... 
 - mit Maus-Klick auf [?] 
 - mit der Tastenkombination [Alt]+[]+[?] 

 

► Maus-Klick auf [?] oder Tastenkombination [Alt]+[]+[?] 

> Öffnet ein neues Fenster mit den Programm-Informationen des Downloaders, z.B.: 

 

► Mit [OK] Fenster schließen. 
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5.8 Schaltflächen 
6197 

 

Die Schaltflächen des Downloaders haben folgende Bedeutungen: 

Schaltfläche Beschreibung 

[Download] Überträgt H86-Dateien vom PC in das Gerät: 

► Mit Windows-Explorer H86-Datei im PC wählen und markieren. 

► Mit [Öffnen] Datei laden. 

> Datei wird in das Gerät geschrieben. 

> Meldung "Download successful" mit [OK] schließen. 

[Upload] Überträgt H86-Dateien vom Gerät in den PC: 

► Liest im Gerät die unter [Options] > [File Options] definierten 
Datei-Elemente als eine Datei. 

► Mit Windows-Explorer Verzeichnis und Dateiname wählen. 

> Mit [Speichern] H86-Datei im PC speichern. 

> Meldung "Upload successful" mit [OK] schließen. 

[Verify] Vergleicht die unter [Options] > [File Options] definierten Datei-
Elemente zwischen Gerät und PC: 

► Mit Windows-Explorer H86-Datei im PC wählen und markieren. 

► Mit [Öffnen] Datei laden. 

> Meldung "Verify successful" mit [OK] schließen. 

[Run] Steuerung im Gerät starten. 

> Statusmeldung (wie bei [Identity]) erscheint. 

[Stop] Steuerung im Gerät anhalten. 

> Statusmeldung (wie bei [Identity]) erscheint. 

[Identity] > Prüft, ob an der gewählten Schnittstelle und mit dem gewählten 
Protokoll ein Gerät angeschlossen und lesbar ist. 

> Liest im Gerät die folgenden Daten: 
 - Dateioptionen 
 - Speicherabbild 
 - Gerätedaten 

> Statusmeldung erscheint. 

[Exit] Beendet das Downloader-Tool. 
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6 Befehlszeilen programmieren 
enthält: 

Befehlszeilenargumente von DOWNLOAD.EXE .........................................................................38 
Ausführbare Kommandos (nur in Verbindung mit /DEBUG)........................................................39 
Beispiel für eine Kommandoliste..................................................................................................40 

6199 

Der Downloader kann in Batch-Programmen mehrere Kommandos in Folge verarbeiten. Die 
Befehlszeilen in den Kommandolisten müssen folgende Kriterien erfüllen: 

 gemäß Windows-Spezifikation, 

 Downloader-Parameter gemäß den folgenden Tabellen. 
 

a) Wenige Kommandos in einer Befehlszeile angeben 

► Mittels Windows-Explorer eine Verknüpfung zum Downloader auf dem Desktop anlegen und der 
Aufgabe entsprechend benennen. 

► Mit Rechtsklick auf die Verknüpfung und Klick auf [Eigenschaften] den Eigenschaften-Dialog 
öffnen. 

► In der Zeile [Ziel] das Kommando zum Start des Downloaders um die gewünschten Kommandos 
erweitern, z.B.: 
"C:\...\DOWNLOAD.exe" /run /identity 

> Die ausführbaren Kommandos werden in der gleichen Reihenfolge abgearbeitet, wie in der 
Befehlszeile angegeben, hier: SPS-Programmablauf starten und Anzeige der Status-Information 
aus dem Gerät. 

 

b) Mit dem Downloader eine Liste von Kommandos abarbeiten 

Wir empfehlen, für jede Serienfertigung eine eigene Kommandoliste als TXT-Datei zu schreiben und 
sinnvoll zu benennen. So sinkt deutlich die Gefahr von fehlerhaften Einstellungen oder 
Datenübertragungen. 

► Mit dem Windows-Editor eine Kommandoliste anlegen und z.B. als CmdLst4711.TXT in einem 
Unterverzeichnis des Downloaders speichern, z.B.: 
C:\Programme\ifm electronic\downloader32\Batch 
 Beispiel für eine Kommandoliste (→ Seite 40) 

► Mittels Windows-Explorer eine Verknüpfung zum Downloader auf dem Desktop anlegen und der 
Aufgabe entsprechend benennen. 

► Mit Rechtsklick auf die Verknüpfung und Klick auf [Eigenschaften] den Eigenschaften-Dialog 
öffnen. 

► In der Zeile [Ziel] das Kommando zum Start des Downloaders um folgendes Kommando 
erweitern: 
"C:\...\DOWNLOAD.exe" /cfBatch\CmdLst4711.txt (ohne Leerzeichen nach "/cf"!) 

> Downloader arbeitet die in der CmdLst4711.TXT aufgeführten Kommandos nacheinander ab. 

> Ausführbare Kommandos laufen durch, ohne auf Benutzer-Eingaben zu warten. 
Ausnahme 1: Fehlermeldungen müssen quittiert werden. 
Ausnahme 2: Das Ergebnis von [Identity] muss quittiert werden. 
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6.1 Befehlszeilenargumente von DOWNLOAD.EXE 
6200 

Die Befehlszeile für den Downloader kann mit einem oder mehreren Argumenten ergänzt werden, um 
eine sinnvolle Funktion zu erfüllen. In folgender Tabelle sind einige der möglichen Argumente 
beschrieben: 

Parameter Beschreibung 

/CFx Command-File ausführen (x = Pfad\Name der Kommandolisten-Datei) 

/LZSVERSIONx x = Nummer des Protokolls (1, 2, 3) 

/RS232 RS232-Schnittstelle verwenden (Default) 

/COMx x = Nummer des COM-Ports (1, 2, ...) 

/CANx CAN-Schnittstelle verwenden (x = Board-Typ, ‘1’ für IPCI 320) 

/BAUDRATEx Beispiele: 
x = 9600 für RS232 oder  
x = 125 für CAN 

/CANINTx Interrupt-Nummer der CAN-Karte (Default = 5hex) 

/CANBASEx Basisadresse der CAN-Karte (Default = D000hex) 

/MODULx Modulnummer der Steuerung 0...31 (Default = 0) 

/VCIVERSIONx x = Version des VCI-Treibers (1 oder 2) 
  

/BASEUSERPROGRAMx Anfangsadresse des Speicherbereichs für das Applikations-Programm  
(Default = 30000hex) 

/BASEFILEFLASHx Anfangsadresse des Speicherbereichs für das Dateisystems 

/FILEFLASHSIZEx x = Größe des Speicherbereichs für das Dateisystems 

/BASEUSERFLASHx Anfangsadresse des Speicherbereichs für die Daten des Applikations-Programms 

/USERFLASHSIZEx x = Größe des Speicherbereichs für die Daten des Applikations-Programms 

/BASEDATAFLASHx Anfangsadresse des Speicherbereichs für die Funktionen FLASH_READ und 
FLASH_WRITE 

/DATAFLASHSIZEx x = Größe des Speicherbereichs für die Funktionen FLASH_READ und FLASH_WRITE

/BASERAMx Anfangsadresse des Speicherbereichs für den flüchtigen Speicher 

/RAMSIZEx x = Größe des Speicherbereichs für den flüchtigen Speicher 

/BASEDATAx Anfangsadresse des Speicherbereichs für die Anwendungsdaten 

/DATASIZEx x = Größe des Speicherbereichs für die Anwendungsdaten 

/BASEMEMORYRETAINx Anfangsadresse des Speicherbereichs spannungsausfallgeschützt, adress-orientiert 

/MEMORYRETAINSIZEx x = Größe des Speicherbereichs spannungsausfallgeschützt, adress-orientiert 

/BASEVARRETAINx Anfangsadresse des Speicherbereichs für Variablen spannungsausfallgeschützt, 
variablen-orientiert 

/VARRETAINSIZEx x = Größe des Speicherbereichs für Variablen spannungsausfallgeschützt, variablen-
orientiert 

/BASEMEMORYx Anfangsadresse des Speichers 

/MEMORYSIZEx x = Größe des Speichers 

/EEPROMSIZEx x = Größe des seriellen EEPROMs (Default = 2000hex) 

/BINANFADRx Anfangsadresse bei BIN-Files (binäre Files) 

/BINENDADRx Endadresse bei BIN-Files (binäre Files) 
  

/BASELZSx Anfangsadresse des Laufzeitsystems 

/LZSSIZEx Größe des Laufzeitsystems 
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Parameter Beschreibung 
 

 

/DEBUG Erweiterte Funktionen zugänglich ( Ausführbare Kommandos (→ Seite 39)) 

/Fx x = Pfad\Name der zu ladenden Datei 
  

/DLFILE Up- / Download von Betriebssystem oder Applikations-Programm (Default) 

/USERFLASHFILE Up- / Download der Flash-Daten (32K ab 70000hex) 

/FILEFLASHFILE Up- / Download der Flash-Daten 

/DATAFLASHFILE Up- / Download der Flash-Daten (16K ab 7C000hex) 

/USERRETAINFILE Up- / Download der Retain-Daten 

/EEPROMFILE Up- / Download der Daten im seriellen EEPROM 
  

/NOCRC Die Prüfsumme der Datei nicht testen 

/CRC Die Prüfsumme der Datei testen (Default) 

/AUTOANSWERx Dialoge automatisch beantworten (x = YES, NO, OK, IGNORE, CANCEL, RETRY) 

/WRITECFG Konfiguration bei Programm-Ende speichern (Default) 

/FCFGx CFG-Datei laden 

/NOVISIBLE Keine Bildschirmausgabe (Ausnahme bei Fehlermeldungen) 
 

 

6.2 Ausführbare Kommandos (nur in Verbindung 
mit /DEBUG) 

6201 

Parameter Beschreibung 

/DOWNLOAD Download durchführen 

/UPLOAD Upload durchführen 

/VERIFY Vergleich durchführen 

/RUN Applikations-Programm starten 

/STOP Applikations-Programm anhalten 

/IDENTITY Kennung lesen 

/SETCANBAUDRATEx Die CAN-Baudrate der Steuerung ändern (x = Baudrate) 

/SETRS232BAUDRATEx Die RS232-Baudrate der Steuerung ändern (x = Baudrate) 

/DELAYx Verzögerung x in [ms] 

/MESSAGEx Meldung x ausgeben 

/EXIT Abarbeitung abbrechen 
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6.3 Beispiel für eine Kommandoliste 
6202 

Die folgende Kommandoliste ist möglichst universell gehalten: 

 Durch Auskommentieren einer Zeile (also "rem" vor die Zeile schreiben) wird die Zeile unwirksam. 

 Durch Entfernen des "rem" vor der einzelnen Zeile wird die Zeile wirksam. 

 Zeilen mit vorangestelltem "REM" bleiben dauerhaft als Kommentar. 
 

REM work with CAN third point from CAN Board type list = ThinCAN (IXXAT) 

rem CAN3 

REM Set baudrate to 125kB 

rem baudrate125 

REM download ID = 32 

rem modul32 
 

REM work with RS232 

rs232 

REM Set port to COM 1 

com1 

REM Set baudrate to 57600 

baudrate57600 
 

REM upload userprogram 

rem fbatch\test_prg.H86 

rem dlfile 

rem upload 
 

REM load userprogram 

rem fbatch\test_prg.H86 

rem dlfile 

rem download 
 

REM load CSV list to FRAM 

rem fbatch\texte2.csv 

rem eepromfile 

rem NOCRC 

rem download 
 

REM load CSV list to Autosave 

fbatch\Flash_texte_test3_safety.csv 

REM USERRETAINFILE 

DATAFLASHFILE 

NOCRC 

download 
 

Rem start PLC 

run 
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REM get identity 

identity 
 

Diese Kommandoliste arbeitet mit dem Downloader nacheinander folgende Aufgaben ab: 

 Kommunikation mit dem Gerät über serielle Schnittstelle auf COM1 mit 57.600 Bd. 

 Datei Flash_texte_test3_safety.csv aus dem Verzeichnis fbatch laden, als 
DATAFLASHFILE definieren und ohne Prüfsummenbildung in das Gerät schreiben. 

 Die SPS im Gerät starten. 

 Die Status-Informationen des Geräts lesen und anzeigen. 
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7 Downloader verwenden (Beispiele) 
enthält: 

Betriebssystem im Gerät aktualisieren.........................................................................................42 
Applikations-Programm in das Gerät schreiben ..........................................................................43 
Applikations-Programm aus dem Gerät lesen .............................................................................44 
Datentabelle anlegen und ins Gerät übertragen ..........................................................................45 

6207 

In diesem Kapitel beschreiben wir Ihnen den Ablauf von einigen Handlungen, für die Sie den 
Downloader nutzen können. 
 

 

7.1 Betriebssystem im Gerät aktualisieren 
6214 

ifm-Geräte werden in der Regel ohne Betriebssystem ausgeliefert. Der Anwender kann das 
Betriebssystem seiner Wahl sofort in das Gerät laden: 

Voraussetzungen: 
 - Gerät ist mit dem PC verbunden. 
 - Schnittstelle ist angewählt und richtig eingestellt. 

► Mit [Identity] Verbindung mit dem Gerät prüfen. 

► Wenn Fehlermeldung erscheint: 
Verbindung und Einstellungen prüfen und korrigieren. 

► Schaltfläche [Download] klicken. 

> Windows-Explorer-Fenster öffnet sich auf der Suche nach einer H86-Datei. 

► Verzeichnis mit dem gewünschten Betriebssystem wählen, z.B.: 
C:\Programme\ifm electronic\CoDeSys V2.3\Targets\ifm\Library\ifm_CR0032. 

► Datei wählen, z.B.: ifm_cr0032_v020102.h86. 

► Mit [Öffnen] den Download in das Gerät starten. 

> Wenn eingestellt: 
Sicherheitsabfrage erscheint, ob Download gestartet werden soll. Mit [Ja] bestätigen. 

> H86-Datei wird in das Gerät geschrieben. 

> Meldung "Download successful" erscheint. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

► Betriebssystem ist im Gerät gespeichert. 

► Mit [Identify] den Status des Geräts lesen und anzeigen. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

> Mit [Exit] Downloader beenden. 
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7.2 Applikations-Programm in das Gerät schreiben 
6215 

Voraussetzung: Im Gerät ist ein Betriebssystem gespeichert. 

► Mit CoDeSys ein Bootprojekt aus dem Applikations-Programm erzeugen: 
 - Applikations-Programm öffnen. 
 - Mit [Online] > [Bootprojekt erzeugen] folgende Dateien erzeugen: 
 Project.PRG, Project.HEX, Project.CHK. 

Der Anwender kann das Applikations-Programm mittels Downloader in das Gerät schreiben, ohne ein 
Programmiersystem wie CoDeSys installiert zu haben: 

Voraussetzungen: 
 - Gerät ist mit dem PC verbunden. 
 - Schnittstelle ist angewählt und richtig eingestellt. 

► Mit [Identity] Verbindung mit dem Gerät prüfen. 

► Wenn Fehlermeldung erscheint: 
Verbindung und Einstellungen prüfen und korrigieren. 

► Schaltfläche [Download] klicken. 

> Windows-Explorer-Fenster öffnet sich auf der Suche nach einer H86-Datei. 

► Verzeichnis mit der gewünschten Applikation wählen. 

► H86-Datei oder PRG-Datei wählen. 

► Mit [Öffnen] den Download in das Gerät starten. 

> Wenn eingestellt: 
Sicherheitsabfrage erscheint, ob Download gestartet werden soll. Mit [Ja] bestätigen. 

> Downloader erzeugt im Verzeichnis der Applikation eine gleichnamige H86-Datei. Eine 
möglicherweise bereits vorhandene Datei gleichen Namens wird dabei ohne Nachfrage 
überschrieben. 

> H86-Datei wird in das Gerät geschrieben. 

> Meldung "Download successful" erscheint. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

> Applikations-Programm ist im Gerät gespeichert. 

► Mit [Run] das Applikations-Programm im Gerät starten. 

► Mit [Identify] den Status des Geräts lesen und anzeigen. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

► Mit [Exit] Downloader beenden. 
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7.3 Applikations-Programm aus dem Gerät lesen 
6216 

Für Sicherheitsanwendungen muss das Applikations-Programm von einer Prüfbehörde zertifiziert 
werden. Dazu erhält die Prüfbehörde eine Kopie der H86-Datei, die (zusammen mit der Prüfsumme) 
aus dem getesteten Gerät gelesen wurde. Wenn die Prüfbehörde das Applikations-Programm 
zertifiziert hat, kann diese H86-Datei anschließend mit dem Downloader in eine Serie von 
gleichartigen Geräten kopiert werden. Nur mit dieser Methode bleibt die Prüfsumme unverändert, was 
für Sicherheitsanwendungen Voraussetzung für deren Zulassung ist. 

Wie wird das Applikations-Programm aus dem Gerät gelesen? 

Voraussetzungen: 
 - Gerät ist mit dem PC verbunden. 
 - Schnittstelle ist angewählt und richtig eingestellt. 

► Mit [Identity] Verbindung mit dem Gerät prüfen. 

► Wenn Fehlermeldung erscheint: 
Verbindung und Einstellungen prüfen und korrigieren. 

► Menü [Security] > [With CRC] wählen. 

► Menü [Options] > [File Options] wählen. 

► Nur die Zeile [Runtime System / Application Program] aktivieren. 
Alle anderen File Options deaktivieren. 

► Einstellung der [File Options] mit [OK] speichern und schließen. 

► Schaltfläche [Upload] klicken. 

> Windows-Explorer-Fenster [Speichern unter] öffnet sich auf der Suche nach einer H86-Datei. 

► Verzeichnis mit der gewünschten Applikation wählen. 

► Gewünschten Dateinamen angeben. 

► Mit [Speichern] den Upload aus dem Gerät starten. 

> Wenn Datei bereits exisitert: 
Sicherheitsabfrage erscheint, ob Upload gestartet werden soll. Mit [Ja] bestätigen. 

> Daten werden aus dem Gerät gelesen und auf der PC-Festplatte gespeichert. 

> Meldung "Upload successful" erscheint. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

> Applikations-Programm ist im PC gespeichert. 

► Mit [Verify] das Applikations-Programm im Gerät mit der auf dem PC gespeicherten H86-Datei 
vergleichen. 

> Meldung "Verfiy successful" erscheint. 

► Mit [OK] Meldung bestätigen und Fenster schließen. 

► Mit [Exit] Downloader beenden. 

► Für Sicherheitsanwendungen: 
Gespeicherte H86-Datei zwecks Zertifizierung bei der Prüfbehörde einreichen. 
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7.4 Datentabelle anlegen und ins Gerät übertragen 
6228 

Für ifm-PDM-Geräte können Meldetexte mehrsprachig in einem Tabellenkalkulationsprogramm 
angelegt werden, z.B.: 

 

In diesem Beispiel gibt der Anwender in Spalte D den Rohtext ein. Das Tabellenkalkulationsprogramm 
übernimmt diese Texte für die Spalte B, wobei die Textlänge automatisch auf hier voreingestellte 
20 Zeichen ergänzt oder reduziert wird. 

In Spalte A sind wichtig: 

 Der Eintrag "ifm data at ..." (hier in Zeile 7): 
Der hier angegebene Wert (FC00hex) ist die Speicher-Startadresse im Gerät und somit auch die 
Offset-Adresse für die einzelnen Textzeilen oder die Offset-Adresse für den ersten Sprachsatz. 
WICHTIG: Dieser Zeile MUSS direkt die erste Datenzeile folgen! Eventuell zum Erstellen der Liste 
erforderliche Überschriften (hier: Zeile 6) müssen oberhalb der Zeile mit der Speicher-
Startadresse stehen! 
WICHTIG: Die Speicher-Startadresse ist abhängig vom Gerät und muss richtig angegeben 
werden! ( Fenster [Memory Settings] (→ Seite 27)) 

 Die Zahlenwerte darunter: 0, 21, 42, ...: 
Dies sind die relativen Startwerte für die einzelnen Textzeilen. Die absolute Adresse ergibt sich 
aus: 
Startadresse (FC00hex) plus relativer Startwert. Der relative Startwert einer Zeile ergibt sich aus 
der Datenlänge der aktuellen Zeile plus dem relativen Startwert der Vorgänger-Zeile ( Hinweis 
zu Spalte C). 

 Die Adressbereiche durchgängig in EINEM Block erstellen. 
Für EEPROMs muss auch der vom Betriebssystem reservierte Speicherbereich (z.B. 
300hex...3FFhex) beschrieben werden. Beim Speichern im EEPROM ist dieser Bereich geschützt 
und wird hierbei nicht überschrieben. ( Fenster [Memory Settings] (→ Seite 27)) 

► In Spalte B die zu übertragenden Daten (Werte oder Texte) eintragen. 

► In Spalte C den jeweils zugehörigen Datentyp eintragen. 
WICHTIG: Ein Datenelement vom Typ STRING wird immer mit dem Wert "00hex" abgeschlossen. 
Daher laufen die Adressangaben im Beispiel oben in einem Raster von 21 Bytes (20 Nutz-Bytes 
plus 1 Terminierungs-Byte) 
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► Diese Tabelle als CSV-Datei mit Trennzeichen speichern: 
 - [;] als Trennzeichen für Spalten, 
 - [CR] als Trennzeichen für Zeilen. 

> Bei der Übertragung in das Gerät erzeugt der Downloader eine H86-Datei mit dem Inhalt der 
Spalten A...C und kopiert sie in den im Fenster [File Options] (→ Seite 25) definierten 
Speicherbereich des Geräts. 

Vorteile dieser Methode: 
 - Deutlich weniger Speicherbedarf, 
 - einfacher Zugriff auf bestimmte Textnummern, 
 - einfaches Umschalten auf andere Sprachsätze im Applikations-Programm durch passendes Ändern 
der Offset-Adresse. 
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8 Begriffe und 
Abkürzungen 

A 

Adresse 

Das ist der „Name“ des Teilnehmers im Bus. 
Alle Teilnehmer benötigen eine 
unverwechselbare, eindeutige Adresse, damit 
der Austausch der Signale fehlerfrei 
funktioniert. 
 

 

Anforderungsrate rd 

Die Anforderungsrate rd ist die Häufigkeit je 
Zeiteinheit von Anforderungen an eine 
sicherheitsgerichtete Reaktion eines SRP/CS. 
 

 

Anleitung 

Übergeordnetes Wort für einen der folgenden 
Begriffe: 
Montageanleitung, Datenblatt, 
Benutzerinformation, Bedienungsanleitung, 
Gerätehandbuch, Installationsanleitung, 
Onlinehilfe, Systemhandbuch, 
Programmierhandbuch, usw. 
 

 

Applikations-Software 

Software, die speziell für die Applikation 
(Anwendung) vom Hersteller in die Maschine 
programmiert wird. Die Software enthält 
üblicherweise logische Sequenzen, 
Grenzwerte und Ausdrücke zum Steuern der 
entsprechenden Ein- und Ausgänge, 
Berechnungen und Entscheidungen. 

Für sicherheitsrelevante Teile von 
Steuerungen (SRP/CS) müssen spezielle 
Anforderungen erfüllt sein. 
 Programmiersprache, sicherheitsrelevant 
 

 

Architektur 

Spezifische Konfiguration von Hardware- und 
Software-Elementen in einem System. 
 

 

Ausfall 

Ausfall ist die Beendigung der Fähigkeit einer 
Einheit, eine geforderte Funktion zu erfüllen. 

Nach einem Ausfall hat die Einheit einen 
Fehler. Der Ausfall ist ein Ereignis, der Fehler 
ein Zustand. 

Der so definierte Begriff kann nicht auf 
Einheiten angewendet werden, die nur aus 
Software bestehen. 
 

 

Ausfall, gefahrbringend 

Ein gefahrbringender Ausfall hat das Potential, 
das SRP/CS in einen gefährlichen Zustand 
oder eine Fehlfunktion zu bringen. Ob dieses 
Potential bemerkt werden kann oder nicht, 
hängt von der Architektur des Systems ab. In 
einem redundanten System wird ein 
gefährlicher Hardware-Ausfall weniger 
wahrscheinlich zu einem gefährlichen Ausfall 
des Gesamtsystems führen. 
 

 

Ausfall, systematischer 

Ein systematischer Ausfall ist ein Ausfall mit 
deterministischem (nicht zufälligem) Bezug zu 
einer bestimmten Ursache. Der systematische 
Ausfall kann nur beseitigt werden durch 
Änderung des Entwurfs oder des 
Herstellprozesses, Betriebsverfahren, 
Dokumentation oder zugehörigen Faktoren. 

Eine Instandsetzung ohne Änderung des 
Systems wird den Grund des systematischen 
Ausfalls in der Regel nicht beseitigen. 
 

 

B 

Baud 

Baud, Abk.: Bd = Maßeinheit für die 
Geschwindigkeit bei der Datenübertragung. 
Baud ist nicht zu verwechseln mit "bits per 
second" (bps, Bit/s). Baud gibt zwar die Anzahl 
von Zustandsänderungen (Schritte, Takte) pro 
Sekunde auf einer Übertragungsstrecke an. 
Aber es ist nicht festgelegt, wie viele Bits pro 
Schritt übertragen werden. Der Name Baud 
geht auf den französischen Erfinder J. M. 
Baudot zurück, dessen Code für Telexgeräte 
verwendet wurde. 

1 MBd = 1024 x 1024 Bd = 1 048 576 Bd 
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Bestimmungsgemäße Verwendung 

Das ist die Verwendung eines Produkts in 
Übereinstimmung mit den in der Anleitung 
bereitgestellten Informationen. 
 

 

Betriebsdauer, mittlere 

Mean time between failures (MTBF) = mittlere 
Betriebsdauer zwischen Ausfällen. 
Ist der Erwartungswert der Betriebsdauer 
zwischen zwei aufeinanderfolgenden Ausfällen 
von Einheiten, die instand gesetzt werden. 

HINWEIS: Für Einheiten, die NICHT 
instandgesetzt werden, ist der Erwartungswert 
(Mittelwert) der Verteilung von Lebensdauern 
die mittlere Lebensdauer MTTF. 
 

 

Betriebssystem 

Grundprogramm im Gerät, stellt die 
Verbindung her zwischen der Hardware des 
Gerätes und der Anwender-Software. 
 

 

Bus 

Serielle Datenübertragung mehrerer 
Teilnehmer an derselben Leitung. 
 

 

C 

CAN 

CAN = Controller Area Network 

CAN gilt als Feldbussystem für größere 
Datenmengen, das prioritätengesteuert 
arbeitet. Gibt es in verschiedenen Varianten 
z.B. als "CANopen" oder "CAN in Automation 
(CiA)." 
 

 

CAN-Stack 

CAN-Stack = Stapel von CAN-
Datenübertragungs-Aufträgen. 
 

 

CCF 

Common cause failure = Ausfall in Folge von 
gemeinsamer Ursache 
Ausfälle verschiedener Einheiten aufgrund 
eines gemeinsamen Ereignisses, wobei diese 
Ausfälle nicht auf gegenseitige Ursachen 
beruhen. 
 

 

CiA 

CiA = CAN in Automation e.V. 

Anwender- und Herstellerorganisation in 
Deutschland / Erlangen. Definitions- und 
Kontrollorgan für CAN und CAN-basierende 
Netzwerkprotokolle. 

Homepage  http://www.can-cia.org 
 

 

CiA DS 304 

DS = Draft Standard 

CAN-Geräteprofil CANopen-Safety für 
sicherheitsgerichtete Kommunikation. 
 

 

CiA DS 401 

DS = Draft Standard 

CAN-Geräteprofil für digitale und analoge E/A-
Baugruppen 
 

 

CiA DS 402 

DS = Draft Standard 

CAN-Geräteprofil für Antriebe 
 

 

CiA DS 403 

DS = Draft Standard 

CAN-Geräteprofil für Bediengeräte 
 

 

CiA DS 404 

DS = Draft Standard 

CAN-Geräteprofil für Messtechnik und Regler 
 

http://www.can-cia.org/�
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CiA DS 405 

DS = Draft Standard 

Spezifikation zur Schnittstelle zu 
programmierbaren Steuerungen (IEC 61131-3) 
 

 

CiA DS 406 

DS = Draft Standard 

CAN-Geräteprofil für Drehgeber / Encoder 
 

 

CiA DS 407 

DS = Draft Standard 

CAN-Applikations-Profil für den öffentlichen 
Nahverkehr 
 

 

COB-ID 

COB = Communication Object = 
Kommunikationsobjekt 
ID = Identifier = Kennung 

Über den COB-ID unterscheiden die 
Teilnehmer die verschiedenen 
auszutauschenden Nachrichten. 
 

 

CoDeSys 

CoDeSys ist eingetragene Marke der 3S – 
Smart Software Solutions GmbH, Deutschland 

"CoDeSys for Automation Alliance" vereinigt 
Firmen der Automatisierungsindustrie, deren 
Hardwaregeräte alle mit dem weit verbreiteten 
IEC 61131-3 Entwicklungswerkzeug CoDeSys 
programmiert werden. 

Homepage  http://www.3s-software.com 
 

 

CRC 

CRC = Cyclic Redundancy Check = zyklische 
Redundanzprüfung 

CRC ist ein Verfahren aus der 
Informationstechnik zur Bestimmung eines 
Prüfwerts für Daten, um Fehler bei der 
Übertragung oder Duplizierung von Daten 
erkennen zu können. 

Vor Beginn der Übertragung eines Blocks der 
Daten wird ein CRC-Wert berechnet. Nach 
Abschluss der Transaktion wird am Zielort der 
CRC-Wert erneut berechnet. Anschließend 
werden diese beiden Prüfwerte verglichen.  
 

 

D 

DC 

Direct Current = Gleichstrom 
 

 

DC 

Diagnostic Coverage = Diagnose-
Deckungsgrad 
Der Diagnose-Deckungsgrad ist das Maß für 
die Wirksamkeit der Diagnose als Verhältnis 
der Ausfallrate der bemerkten 
gefahrbringenden Ausfälle und der Ausfallrate 
der gesamten gefahrbringenden Ausfälle: 

Formel: DC = Ausfallrate bemerkte gefahrbringende 
Ausfälle / Ausfallrate gesamte gefahrbringende Ausfälle 

Bezeichnung Bereich 

kein DC < 60 % 

niedrig 60 % < DC < 90 % 

mittel 90 % < DC < 99 % 

hoch 99 % < DC 

Tabelle: Diagnose-Deckungsgrad DC 

Für die in der Tabelle gezeigten Grenzwerte 
wird eine Genauigkeit von 5 % angenommen. 

Der Diagnose-Deckungsgrad kann für das 
gesamte sicherheitsgerichtete System ermittelt 
werden oder nur für Teile des 
sicherheitsgerichteten Systems. 
 

 

Diagnose 

Bei der Diagnose wird der 
"Gesundheitszustand" des Gerätes geprüft. Es 
soll festgestellt werden, ob und gegebenenfalls 
welche Fehler im Gerät vorhanden sind. 

Je nach Gerät können auch die Ein- und 
Ausgänge auf einwandfreie Funktion 
überwacht werden: 
 - Drahtbruch, 
 - Kurzschluss, 
 - Wert außerhalb des Sollbereichs. 

http://www.3s-software.com/�
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Zur Diagnose können Konfigurations-Dateien 
herangezogen werden, die während des 
"normalen" Betriebs des Gerätes erzeugt 
wurden. 

Der korrekte Start der Systemkomponenten 
wird während der Initialisierungs- und 
Startphase überwacht. 

Zur weiteren Diagnose können auch 
Selbsttests durchgeführt werden. 
 

 

Diagnose-Deckungsgrad 

Diagnostic Coverage = Diagnose-
Deckungsgrad 
Der Diagnose-Deckungsgrad ist das Maß für 
die Wirksamkeit der Diagnose als Verhältnis 
der Ausfallrate der bemerkten 
gefahrbringenden Ausfälle und der Ausfallrate 
der gesamten gefahrbringenden Ausfälle: 

Formel: DC = Ausfallrate bemerkte gefahrbringende 
Ausfälle / Ausfallrate gesamte gefahrbringende Ausfälle 

Bezeichnung Bereich 

kein DC < 60 % 

niedrig 60 % < DC < 90 % 

mittel 90 % < DC < 99 % 

hoch 99 % < DC 

Tabelle: Diagnose-Deckungsgrad DC 

Für die in der Tabelle gezeigten Grenzwerte 
wird eine Genauigkeit von 5 % angenommen. 

Der Diagnose-Deckungsgrad kann für das 
gesamte sicherheitsgerichtete System ermittelt 
werden oder nur für Teile des 
sicherheitsgerichteten Systems. 
 

 

Dither 

to dither (engl.) = schwanken / zittern 

Dither ist ein Bestandteil der PWM-Signale 
zum Ansteuern von Hydraulik-Ventilen. Für die 
elektromagnetischen Antriebe von Hydraulik-
Ventilen hat sich herausgestellt, dass sich die 
Ventile viel besser regeln lassen, wenn das 
Steuersignal (PWM-Impulse) mit einer 
bestimmten Frequenz der PWM-Frequenz 
überlagert wird. Diese Dither-Frequenz muss 
ein ganzzahliger Teil der PWM-Frequenz sein. 
 

 

diversitär 

Unter Diversität (Vielfalt) versteht man in der 
Technik eine Strategie zur Erhöhung der 
Ausfallsicherheit. 

Dabei werden Systeme redundant ausgelegt, 
allerdings werden bewusst verschiedene 
Realisierungen und keine baugleichen 
Einzelsysteme verwendet. Man geht davon 
aus, dass Systeme, die das Gleiche leisten, 
aber unterschiedlich realisiert sind, auch 
gegen unterschiedliche Störungen empfindlich 
oder unempfindlich sind und daher möglichst 
nicht alle gleichzeitig ausfallen. 

Die konkrete Realisierung kann je nach 
Einsatzgebiet und geforderter Sicherheit 
unterschiedlich aussehen: 

 Verwendung von Bauteilen verschiedener 
Hersteller, 

 Nutzung unterschiedlicher Protokolle zur 
Steuerung von Geräten, 

 Verwendung komplett unterschiedlicher 
Technologien, beispielsweise einer 
elektrischen und einer pneumatischen 
Steuerung, 

 Verwendung unterschiedlicher 
Messmethoden (Strom, Spannung), 

 zwei Kanäle mit gegenläufigen 
Werteverläufen: 
Kanal A: 0...100 % 
Kanal B: 100...0 % 

 

 

DRAM 

DRAM = Dynamic Random Access Memory 

Technologie für einen elektronischen 
Speicherbaustein mit wahlfreiem Zugriff 
(Random Access Memory, RAM). Das 
speichernde Element ist dabei ein 
Kondensator, der entweder geladen oder 
entladen ist. Über einen Schalttransistor wird 
er zugänglich und entweder ausgelesen oder 
mit neuem Inhalt beschrieben. Der 
Speicherinhalt ist flüchtig: die gespeicherte 
Information geht bei fehlender 
Betriebsspannung oder zu später 
Wiederauffrischung verloren. 
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DTC 

DTC = Diagnostic Trouble Code = Fehler-
Code 
Störungen und Fehler werden über 
zugeordnete Nummern – den DTCs – 
verwaltet und gemeldet. 
 

 

E 

ECU 

(1) Electronic Control Unit = Steuergerät oder 
Mikrocontroller 
(2) Engine Control Unit = Steuergerät eines 
Motors 
 

 

EDS-Datei 

EDS = Electronic Data Sheet = elektronisch 
hinterlegtes Datenblatt, z.B. für: 

 Datei für das Objektverzeichnis im Master 

 CANopen-Gerätebeschreibungen 

Via EDS können vereinfacht Geräte und 
Programme ihre Spezifikationen austauschen 
und gegenseitig berücksichtigen. 
 

 

Embedded Software 

System-Software, Grundprogramm im Gerät, 
praktisch das Betriebssystem. 

Die Firmware stellt die Verbindung her 
zwischen der Hardware des Gerätes und der 
Anwender-Software. Diese Software wird vom 
Hersteller der Steuerung als Teil des Systems 
geliefert und kann vom Anwender nicht 
verändert werden. 
 

 

EMCY 

Abkürzung für Emergency (engl.) = Notfall 
 

 

EMV 

EMV = Elektro-Magnetische Verträglichkeit 

Gemäß der EG-Richtlinie (2004/108/EG) zur 
elektromagnetischen Verträglichkeit (kurz 
EMV-Richtlinie) werden Anforderungen an die 
Fähigkeit von elektrischen und elektronischen 
Apparaten, Anlagen, Systemen oder Bauteilen 
gestellt, in der vorhandenen 
elektromagnetischen Umwelt zufriedenstellend 
zu arbeiten. Die Geräte dürfen ihre Umgebung 
nicht stören und dürfen sich von äußerlichen 
elektromagnetischen Störungen nicht 
ungünstig beeinflussen lassen. 
 

 

Erstfehler-Eintrittszeit 

Das ist die Zeit bis zum ersten Versagen eines 
Sicherheitselements. 

Im Zeitraum von maximal 30 s überprüft das 
Betriebssystem mittels interner 
Überwachungs- und Testroutinen die 
Steuerung. 

Diese „Testzykluszeit“ muss kleiner sein als 
die statistische Erstfehler-Eintrittszeit für die 
Applikation. 
 

 

Ethernet 

Das Ethernet ist eine weit verbreitete, 
herstellerneutrale Technologie, mit der im 
Netzwerk Daten mit einer Geschwindigkeit von 
10 oder 100 Millionen Bit pro Sekunde (Mbps) 
übertragen werden können. Das Ethernet 
gehört zu der Familie der sogenannten 
„bestmöglichen Datenübermittlung“ auf einem 
nicht exklusiven Übertragungsmedium. 1972 
entwickelt, wurde das Konzept 1985 als 
IEEE 802.3 spezifiziert. 
 

 

EUC 

EUC = „equipment under control" (kontrollierte 
Einrichtung) 
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EUC ist eine Einrichtung, Maschine, Gerät 
oder Anlage, verwendet zur Fertigung, 
Stoffumformung, zum Transport, zu 
medizinischen oder anderen Tätigkeiten 
( IEC 61508-4, Abschnitt 3.2.3). Das EUC 
umfasst also alle Einrichtungen, Maschinen, 
Geräte oder Anlagen, die Gefährdungen 
verursachen können und für die 
sicherheitsgerichtete Systeme erforderlich 
sind. 

Falls eine vernünftigerweise vorhersehbare 
Aktivität oder Inaktivität zu durch das EUC 
verursachten Gefährdungen mit 
unvertretbarem Risiko führt, sind 
Sicherheitsfunktionen erforderlich, um einen 
sicheren Zustand für das EUC zu erreichen 
oder aufrecht zu erhalten. Diese 
Sicherheitsfunktionen werden durch ein oder 
mehrere sicherheitsgerichtete Systeme 
ausgeführt. 
 

 

F 

Fehlanwendung 

Das ist die Verwendung eines Produkts in 
einer Weise, die vom Konstrukteur nicht 
vorgesehen ist. Eine Fehlanwendung führt 
meist zu einer Gefährdung von Personen oder 
Sachen. 

Vor vernünftigerweise, vorhersehbaren 
Fehlanwendungen muss der Hersteller des 
Produkts in seinen Benutzerinformationen 
warnen. 
 

 

Fehler 

Ein Fehler ist die Unfähigkeit einer Einheit, 
eine geforderte Funktion auszuführen.  

Kein Fehler ist diese Unfähigkeit während 
vorbeugender Wartung oder anderer geplanter 
Handlungen oder aufgrund des Fehlers 
externer Mittel. 

Ein Fehler ist oft das Resultat eines Ausfalls 
der Einheit selbst, kann aber ohne vorherigen 
Ausfall bestehen. 

In der ISO 13849-1 ist mit "Fehler" der 
"zufällige Fehler" gemeint. 
 

 

Fehler-Toleranzzeit 

Das ist die maximale Zeit, die zwischen dem 
Entstehen eines Fehlers und der Einnahme 
des sicheren Zustandes in der Applikation 
vergehen darf, ohne dass eine Gefahr für 
Personen zu befürchten ist. 

Dabei ist die maximale Zykluszeit des 
Applikations-Programms (im ungünstigsten 
Fall 100 ms) und die möglichen Verzögerungs- 
und Reaktionszeiten durch Abschaltglieder zu 
berücksichtigen. 

Die sich daraus ergebende Gesamtzeit muss 
kleiner sein als die Fehler-Toleranzzeit der 
Applikation. 
 

 

FiFo 

FiFo (First In, First Out) = Arbeitsweise des 
Stapelspeichers: Das Datenpaket, das zuerst 
in den Stapelspeicher geschrieben wurde, wird 
auch als erstes gelesen. Pro Identifier steht ein 
solcher Zwischenspeicher (als Warteschlange) 
zur Verfügung. 
 

 

Firmware 

System-Software, Grundprogramm im Gerät, 
praktisch das Betriebssystem. 

Die Firmware stellt die Verbindung her 
zwischen der Hardware des Gerätes und der 
Anwender-Software. Diese Software wird vom 
Hersteller der Steuerung als Teil des Systems 
geliefert und kann vom Anwender nicht 
verändert werden. 
 

 

Flash-Speicher 

Flash-ROM (oder Flash-EPROM oder Flash-
Memory) kombiniert die Vorteile von 
Halbleiterspeicher und Festplatten. Wie jeder 
andere Halbleiterspeicher kommt Flash-
Speicher ohne bewegliche Teile aus. Und die 
Daten bleiben wie bei einer Festplatte auch 
nach dem Ausschalten erhalten. 

Der Flash-ROM hat sich aus dem EEPROM 
(Electrical Erasable and Programmable Read-
Only Memory) entwickelt. Beim Flash-ROM ist 
die Speicherung von Daten funktionell 
identisch wie beim EEPROM. Die Daten 
werden allerdings wie bei einer Festplatte 
blockweise in Datenblöcken zu 64, 128, 256, 
1024, ... Byte zugleich geschrieben und 
gelöscht. 
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Vorteile von Flash-Speicher 

 Die gespeicherten Daten bleiben auch bei 
fehlender Versorgungsspannung erhalten. 

 Wegen fehlender beweglicher Teile ist 
Flash geräuschlos, unempfindlich gegen 
Erschütterungen und magnetische Felder.  

 Im Vergleich zu Festplatten haben Flash-
Speicher eine sehr kurze Zugriffszeit. 
Lese- und Schreibgeschwindigkeit sind 
über den gesamten Speicherbereich 
weitestgehend konstant.  

 Die erreichbare Speichergröße ist durch 
die einfache und platzsparende Anordnung 
der Speicherzellen nach oben offen.  

Nachteile von Flash-Speicher 

 Begrenzte Zahl von Schreib- bzw. 
Löschvorgängen, die eine Speicherzelle 
vertragen kann:  
 - Multi-Level-Cells: typ. 10 000 Zyklen 
 - Single-Level-Cells: typ. 100 000 Zyklen 

 Da ein Schreibvorgang Speicherblöcke 
zwischen 16 und 128 kByte gleichzeitig 
beschreibt, werden auch Speicherzellen 
beansprucht, die gar keiner Veränderung 
bedürfen. 

 

 

FMEA 

FMEA = Failure Mode and Effects Analysis = 
Fehler-Möglichkeits- und Einfluss-Analyse 

Methode der Zuverlässigkeitstechnik, um 
potenzielle Schwachstellen zu finden. Im 
Rahmen des Qualitäts- oder 
Sicherheitsmanagements wird die FMEA zur 
Fehlervermeidung und Erhöhung der 
technischen Zuverlässigkeit vorbeugend 
eingesetzt. 

 
 

FRAM 

FRAM, oder auch FeRAM, bedeutet 
Ferroelectric Random Access Memory. Der 
Speicher- und Löschvorgang erfolgt durch eine 
Polarisationsänderung in einer 
ferroelektrischen Schicht. 

Vorteile von FRAM gegenüber herkömmlichen 
Festwertspeichern: 

 nicht flüchtig, 

 kompatibel zu gängigen EEPROMs, 
jedoch: 

 Zugriffszeit ca. 100 ns, 

 fast unbegrenzt viele Zugriffszyklen 
möglich. 

 

 

Funktionale Sicherheit 

Teil der Gesamtsicherheit, bezogen auf das 
EUC und das EUC-Leit- oder 
Steuerungssystem, die von der korrekten 
Funktion des elektrischen oder elektronischen 
sicherheitsgerichteten Systems, 
sicherheitsgerichteten Systemen anderer 
Technologien und externer Einrichtungen zur 
Risikominderung abhängt.  
 

 

G 

Gebrauchsdauer Tm 

Die Gebrauchsdauer TM ist der Zeitraum, der 
die vorgegebene Verwendung der SRP/CS 
abdeckt. 
 

 

Gefährdung 

Mit Gefährdung bezeichnet man eine 
potentielle Schadensquelle. 

Man unterscheidet den Ursprung der 
Gefährdung, z.B.: 
 - mechanische Gefährdung, 
 - elektrische Gefährdung, 
oder die Art des zu erwartenden Schadens, 
z.B.: 
 - Gefährdung durch elektrischen Schlag, 
 - Gefährdung durch Schneiden, 
 - Gefährdung durch Vergiftung. 

Die Gefährdung im Sinne dieser Definition ist 
bei der bestimmungsgemäßen Verwendung 
der Maschine entweder dauerhaft vorhanden, 
z.B.: 
 - Bewegung von gefährdenden beweglichen 
Teilen, 
 - Lichtbogen beim Schweißen, 
 - ungesunde Körperhaltung, 
 - Geräusch-Emission, 
 - hohe Temperatur, 
oder die Gefährdung kann unerwartet 
auftreten, z.B.: 
 - Explosion, 
 - Gefährdung durch Quetschen als Folge 
eines unbeabsichtigten / unerwarteten Anlaufs, 
 - Herausschleudern als Folge eines Bruchs, 
 - Stürzen als Folge von 
Geschwindigkeitsänderung. 
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H 

Heartbeat 

Heartbeat (engl.) = Herzschlag 

Die Teilnehmer senden regelmäßig kurze 
Signale. So können die anderen Teilnehmer 
prüfen, ob ein Teilnehmer ausgefallen ist. 
Dazu ist kein Master erforderlich. 
 

 

HMI 

HMI = Human Machine Interface = Mensch-
Maschine-Schnittstelle 
 

 

I 

ID - Identifier 

ID = Identifier = Kennung 

Name zur Unterscheidung der an einem 
System angeschlossenen Geräte / Teilnehmer 
oder der zwischen den Teilnehmern 
ausgetauschten Nachrichtenpakete. 
 

 

IEC-User-Zyklus 

IEC-User-Zyklus = SPS-Zyklus im CoDeSys-
Applikations-Programm. 
 

 

IP-Adresse 

IP = Internet Protocol = Internet-Protokoll 

Die IP-Adresse ist eine Nummer, die zur 
eindeutigen Identifizierung eines Internet-
Teilnehmers notwendig ist. Zur besseren 
Übersicht wird die Nummer in 4 dezimalen 
Werten geschrieben, z. B. 127.215.205.156. 
 

 

ISO 11898 

Norm: "Straßenfahrzeuge – CAN-Protokoll" 

Teil 1: "Bit-Übertragungsschicht und 
physikalische Zeichenabgabe" 

Teil 2: "High-speed medium access unit" 

Teil 3: "Fehlertolerante Schnittstelle für 
niedrige Geschwindigkeiten" 

Teil 4: "Zeitgesteuerte Kommunikation" 

Teil 5: "High-speed medium access unit with 
low-power mode" 
 

 

ISO 11992 

Norm: "Straßenfahrzeuge – Austausch von 
digitalen Informationen über elektrische 
Verbindungen zwischen Zugfahrzeugen und 
Anhängefahrzeugen" 

Teil 1: "Bit-Übertragungsschicht und 
Sicherungsschicht" 

Teil 2: "Anwendungsschicht für die 
Bremsausrüstung" 

Teil 3: "Anwendungsschicht für andere als die 
Bremsausrüstung" 

Teil 4: "Diagnose" 
 

 

ISO 16845 

Norm: "Straßenfahrzeuge – Steuergerätenetz 
(CAN) – Prüfplan zu Konformität" 
 

 

K 

Kategorie (CAT) 

Einstufung der sicherheitsrelevante Teile einer 
Steuerung bezüglich ihres Widerstandes 
gegen Fehler und ihres nachfolgenden 
Verhaltens bei einem Fehler. Diese Sicherheit 
wird erreicht durch die Struktur der Anordnung 
der Teile, die Fehlererkennung und/oder ihre 
Zuverlässigkeit. ( EN 954) 
 

 

Klemme 15 

Klemme 15 ist in Fahrzeugen die vom 
Zündschloss geschaltete Plusleitung. 
 

 

L 

Lebensdauer, mittlere 

Mean time to failure (MTTF) = mittlere Dauer 
bis zum Ausfall oder: mittlere Lebensdauer. 
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Die MTTFd ist die erwartete mittlere Zeit bis 
zum gefahrbringenden Ausfall. 

Bezeichnung Bereich 

niedrig 3 Jahre < MTTFd < 10 Jahre 

mittel 10 Jahre < MTTFd < 30 Jahre 

hoch 30 Jahre < MTTFd < 100 Jahre 

Tabelle: Mittlere Zeit jedes Kanals bis zum 
gefahrbringenden Ausfall MTTFd 

 

 

LED 

LED = Light Emitting Diode = Licht 
aussendende Diode 

Leuchtdiode, auch Luminiszenzdiode, ein 
elektronisches Element mit hoher, farbiger 
Leuchtkraft auf kleinem Volumen bei 
vernachlässigbarer Verlustleistung. 
 

 

LSB 

Least Significant Bit/Byte = Niederwertigstes 
Bit/Byte in einer Reihe von Bit/Bytes. 
 

 

M 

MAC-ID 

MAC = Manufacturer‘s Address Code  
= Hersteller-Seriennummer  

ID = Identifier = Kennung 

Jede Netzwerkkarte verfügt über eine so 
genannte MAC-Adresse, ein 
unverwechselbarer, auf der ganzen Welt 
einzigartiger Zahlencode – quasi eine Art 
Seriennummer. So eine MAC-Adresse ist eine 
Aneinanderreihung von 6 Hexadezimalzahlen, 
etwa "00-0C-6E-D0-02-3F". 
 

 

Master 

Wickelt die komplette Organisation auf dem 
Bus ab. Der Master entscheidet über den 
zeitlichen Buszugriff und fragt die Slaves 
zyklisch ab. 
 

 

MMI 

MMI = Mensch-Maschine-Interface 
 HMI (→ Seite 54) 
 

 

MRAM 

MRAM bedeutet Magnetoresistive Random 
Access Memory. Die Informationen werden mit 
magnetischen Ladungselementen gespeichert. 
Dabei wird die Eigenschaft bestimmter 
Materialien ausgenutzt, die ihren elektrischen 
Widerstand unter dem Einfluss magnetischer 
Felder ändern. 

Vorteile von MRAM gegenüber herkömmlichen 
Festwertspeichern: 

 nicht flüchtig (wie FRAM), jedoch: 

 Zugriffszeit nur ca. 35 ns, 

 unendlich viele Zugriffszyklen möglich. 
 

 

MSB 

Most Significant Bit/Byte = Höchstwertigstes 
Bit/Byte einer Reihe von Bits/Bytes. 
 

 

MTBF 

Mean time between failures (MTBF) = mittlere 
Betriebsdauer zwischen Ausfällen. 
Ist der Erwartungswert der Betriebsdauer 
zwischen zwei aufeinanderfolgenden Ausfällen 
von Einheiten, die instand gesetzt werden. 

HINWEIS: Für Einheiten, die NICHT 
instandgesetzt werden, ist der Erwartungswert 
(Mittelwert) der Verteilung von Lebensdauern 
die mittlere Lebensdauer MTTF. 
 

 

MTTF 

Mean time to failure (MTTF) = mittlere Dauer 
bis zum Ausfall oder: mittlere Lebensdauer. 
 

 

MTTFd 

Mean time to failure (MTTF) = mittlere Dauer 
bis zum Ausfall oder: mittlere Lebensdauer. 

Die MTTFd ist die erwartete mittlere Zeit bis 
zum gefahrbringenden Ausfall. 

Bezeichnung Bereich 

niedrig 3 Jahre < MTTFd < 10 Jahre 

mittel 10 Jahre < MTTFd < 30 Jahre 

hoch 30 Jahre < MTTFd < 100 Jahre 

Tabelle: Mittlere Zeit jedes Kanals bis zum 
gefahrbringenden Ausfall MTTFd 
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Muting 

Mit Muting bezeichnet man die 
vorübergehende und automatische 
Unterdrückung einer Sicherheitsfunktion durch 
das SRP/CS. 

Beispiel: Der Sicherheits-Lichtvorhang ist 
überbrückt, wenn die schließenden Werkzeuge 
unter einen fingersicheren Abstand zueinander 
gelangt sind. Die bedienende Person kann nun 
gefahrlos an die Maschine herantreten und 
das Werkstück führen. 
 

 

N 

NMT 

NMT = Network Management = Netzwerk-
Verwaltung (hier: im CAN-Bus) 

Der NMT-Master steuert die Betriebszustände 
der NMT-Slaves. 
 

 

Node 

Node (engl.) = Knoten. Damit ist ein 
Teilnehmer im Netzwerk gemeint. 
 

 

Node Guarding 

Node (engl.) = Knoten, hier: 
Netzwerkteilnehmer 
Guarding (engl.) = Schutz 

Parametrierbare, zyklische Überwachung von 
jedem entsprechend konfigurierten Slave. Der 
Master prüft, ob die Slaves rechtzeitig 
antworten. Die Slaves prüfen, ob der Master 
regelmäßig anfragt. Somit können 
ausgefallene Netzwerkteilnehmer schnell 
erkannt und gemeldet werden. 
 

 

O 

Obj / Objekt 

Oberbegriff für austauschbare Daten / 
Botschaften innerhalb des CANopen-
Netzwerks. 
 

 

Objektverzeichnis 

Das Objektverzeichnis OBV enthält alle 
CANopen-Kommunikationsparameter eines 
Gerätes, sowie gerätespezifische Parameter 
und Daten. 
 

 

OBV 

Das Objektverzeichnis OBV enthält alle 
CANopen-Kommunikationsparameter eines 
Gerätes, sowie gerätespezifische Parameter 
und Daten. 

 
 

 

operational 

Operational (engl.) = betriebsbereit 

Betriebszustand eines CANopen-Teilnehmers. 
In diesem Modus können SDOs, NMT-
Kommandos und PDOs übertragen werden. 
 

 

P 

PC-Karte 

 PCMCIA-Karte 
 

 

PCMCIA-Karte 

PCMCIA = Personal Computer Memory Card 
International Association, ein Standard für 
Erweiterungskarten mobiler Computer. 
Seit der Einführung des Cardbus-Standards 
1995 werden PCMCIA-Karten auch als PC-
Karte (engl.: PC Card) bezeichnet. 
 

 

PDM 

PDM = Process and Dialog Module = Prozess- 
und Dialog-Monitor 

Gerät zur Kommunikation des Bedieners mit 
der Maschine / Anlage. 
 

 

PDO 

PDO = Process Data Object = Nachrichten-
Objekt mit Prozessdaten. 

Die zeitkritischen Prozessdaten werden mit 
Hilfe der "Process Data Objects" (PDOs) 
übertragen. Die PDOs können beliebig 



 

57 

ifm Programmhandbuch ecomatmobile Downloader 32 

Begriffe und Abkürzungen  

zwischen den einzelnen Knoten ausgetauscht 
werden (PDO-Linking). Zusätzlich wird 
festgelegt, ob der Datenaustausch 
ereignisgesteuert (asynchron) oder 
synchronisiert erfolgen soll. Je nach der Art 
der zu übertragenden Daten kann die richtige 
Wahl der Übertragungsart zu einer erheblichen 
Entlastung des CAN-Bus führen. 

Diese Dienste sind vom Protokoll her nicht 
bestätigte Dienste, d.h. es gibt keine Kontrolle, 
ob die Nachricht auch beim Empfänger 
ankommt. Netzwerkvariablen-Austausch 
entspricht einer "1-zu-n-Verbindung" (1 Sender 
zu n Empfängern). 
 

 

PDU 

PDU = Protocol Data Unit = Protokoll-Daten-
Einheit 

Die PDU ist ein Begriff aus dem CAN-Protokoll 
SAE J1939. Sie bezeichnet einen Bestandteil 
der Ziel- oder Quelladresse. 
 

 

Performance-Level 

Performance-Level 
Ist nach ISO 13849-1 eine Einstufung 
(PL a...e) der Fähigkeit von 
sicherheitsrelevanten Teilen einer Steuerung, 
eine Sicherheitsfunktion unter vorhersehbaren 
Bedingungen auszuführen. 
 

 

PES 

Programable electronic system = 
Programmierbares elektronisches System 
Ein programmierbares elektronisches System 
ist ein System ... 
 - zur Steuerung, zum Schutz oder zur 
Überwachung, 
 - auf der Basis einer oder mehrerer 
programmierbarer Geräte, 
 - einschließlich aller Elemente dieses 
Systems, wie Ein- und Ausgabegeräte. 
 

 

PGN 

PGN = Parameter Group Number = 
Parameter-Gruppennummer 
PGN = PDU Format (PF) + PDU Source (PS) 

Die Parameter-Gruppennummer ist ein Begriff 
aus dem CAN-Protokoll SAE J1939. Sie fasst 
die Teiladressen PF und PS zusammen. 
 

 

PID-Regler 

P = Proportional-Anteil 
Der P-Regler besteht ausschließlich aus einem 
proportionalen Anteil der Verstärkung Kp. Mit 
seinem Ausgangssignal ist er proportional dem 
Eingangssignal. 

 

I = Integral-Anteil 
Ein I-Regler wirkt durch zeitliche Integration 
der Regelabweichung auf die Stellgröße mit 
der Gewichtung durch die Nachstellzeit TN 

 

D = Differential-Anteil 
Der D-Regler reagiert nicht auf die 
Regelabweichung, sondern nur auf deren 
Änderungsgeschwindigkeit. 

 
 

 

Piktogramm 

Piktogramme sind bildhafte Symbole, die eine 
Information durch vereinfachte grafische 
Darstellung vermitteln. 

 Kapitel Was bedeuten die Symbole und 
Formatierungen? (→ Seite 5) 
 

 

PL 

Performance-Level 
Ist nach ISO 13849-1 eine Einstufung 
(PL a...e) der Fähigkeit von 
sicherheitsrelevanten Teilen einer Steuerung, 
eine Sicherheitsfunktion unter vorhersehbaren 
Bedingungen auszuführen. 
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PLr 

Mit dem "erforderlichen Performance-Level" 
PLr wird nach ISO 13849 die erforderliche 
Risikominderung für jede Sicherheitsfunktion 
erreicht. 

Für jede gewählte Sicherheitsfunktion, die 
durch ein SRP/CS ausgeführt wird, muss ein 
PLr festgelegt und dokumentiert werden. Die 
Bestimmung des PLr ist das Ergebnis der 
Risikobeurteilung, bezogen auf den Anteil der 
Risikominderung durch die 
sicherheitsrelevanten Teile der Steuerung. 
 

 

Pre-Op 

Pre-Op = PRE-OPERATIONAL mode (engl.) = 
Zustand vor betriebsbereit 

Betriebszustand eines CANopen-Teilnehmers. 
Nach dem Einschalten der 
Versorgungsspannung geht jeder Teilnehmer 
automatisch in diesem Zustand. Im CANopen-
Netz können in diesem Modus nur SDOs und 
NMT-Kommandos übertragen werden, jedoch 
keine Prozessdaten. 
 

 

prepared 

prepared (engl.) = vorbereitet (auch: 
angehalten) 

Betriebszustand eines CANopen-Teilnehmers. 
In diesem Modus werden nur NMT-
Kommandos übertragen. 
 

 

Programmiersprache, 
sicherheitsrelevant 

Für sicherheitsrelevante Applikationen sollten 
nur folgende Programmiersprachen verwendet 
werden: 

 Programmiersprache mit eingeschränktem 
Sprachumfang (LVL = limited variability 
language), kann vordefinierte, 
applikations-spezifische 
Bibliotheksfunktionen kombinieren. 
In CoDeSys sind das Kontaktplan KOP 
(Ladder Diagram LD) und Funktionsplan 
FUP (Function block diagram FBD). 

 Programmiersprache mit nicht 
eingeschränktem Sprachumfang (FVL = 
full variability language), kann einen 
großen Bereich von Funktionen 
kombinieren. 
Dazu gehören z.B. C, C++, Assembler. In 
CoDeSys ist das Strukturierter Text (ST). 

► Strukturierter Text ist ausschließlich in 
gesonderten, zertifizierten Funktionen zu 
empfehlen, normalerweise in Embedded 
Software. 

► Im "normalen" Applikations-Programm 
sollten nur KOP (LD) und FUP (FBD) 
eingesetzt werden. Damit sollen die 
folgenden Mindestanforderungen erfüllt 
werden können. 

Generell werden folgende 
Mindestanforderungen an sicherheitsrelevante 
Applikations-Software (SRASW) gestellt: 

► Programm modular und klar strukturieren. 
Folge: einfache Testbarkeit. 

► Funktionen verständlich darstellen: 
 - für den Operator auf dem Bildschirm 
(Navigation), 
 - Lesbarkeit des späteren 
Dokumentationsausdrucks. 

► Symbolische Variablen verwenden (keine 
IEC-Adressen). 

► Variablennamen und Kommentare 
aussagekräftig formulieren. 

► Einfache Funktionen verwenden (keine 
indirekte Adressierung, keine 
Variablenfelder). 

► Defensiv programmieren. 

► Leichtes Erweitern oder Anpassen des 
Programms ermöglichen. 

 

 

Prozessabbild 

Mit Prozessabbild bezeichnet man den 
Zustand der Ein- und Ausgänge, mit denen die 
SPS innerhalb eines Zyklusses arbeitet. 

 Am Zyklus-Beginn liest die SPS die 
Zustände aller Eingänge in das 
Prozessabbild ein. 
Während des Zyklusses kann die SPS 
Änderungen an den Eingängen nicht 
erkennen. 
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 Im Laufe des Zyklusses werden die 
Ausgänge nur virtuell (im Prozessabbild) 
geändert. 

 Am Zyklus-Ende schreibt die SPS die 
virtuellen Ausgangszustände auf die 
realen Ausgänge. 

 

 

PWM 

PWM = Puls-Weiten-Modulation 

Via PWM kann ein (vom Gerät dazu 
befähigter) digitaler Ausgang mittels 
regelmäßiger, schneller Impulse eine beinahe 
analoge Spannung ausgeben. Bei dem PWM-
Ausgangssignal handelt es sich um ein 
getaktetes Signal zwischen GND und 
Versorgungsspannung.  

Innerhalb einer festen Periode (PWM-
Frequenz) wird das Puls-/Pausenverhältnis 
variiert. Durch die angeschlossene Last stellt 
sich je nach Puls-/Pausenverhältnis der 
entsprechende Effektivstrom ein. 
 

 

R 

Ratio 

Ratio (lat.) = Verhältnis 

Messungen können auch ratiometrisch 
erfolgen = Verhältnismessung. Das 
Eingangssignal erzeugt ein Ausgangssignal, 
das in einem bestimmten Verhältnis zu ihm 
liegt. Das bedeutet, ohne zusätzliche 
Referenzspannung können analoge 
Eingangssignale ausgewertet werden. Ein 
Schwanken der Versorgungsspannung hat auf 
diesen Messwert dann keinen Einfluss. 
 

 

RAW-CAN 

RAW-CAN bezeichnet das reine CAN-
Protokoll, das ohne ein zusätzliches 
Kommunikationsprotokoll auf dem CAN-Bus 
(auf ISO/OSI-Schicht 2) arbeitet. Das CAN-
Protokoll ist international nach ISO 11898-1 
definiert und garantiert zusätzlich in ISO 16845 
die Austauschbarkeit von CAN-Chips. 
 

 

redundant 

Redundanz ist das Vorhandensein von mehr 
als den notwendigen Mitteln, damit eine 
Funktionseinheit eine geforderte Funktion 
ausführt oder damit Daten eine Information 
darstellen können. 

Man unterscheidet verschiedene Arten der 
Redundanz: 

 Die funktionelle Redundanz zielt darauf ab, 
sicherheitstechnische Systeme mehrfach 
parallel auszulegen, damit beim Ausfall 
einer Komponente die anderen den Dienst 
gewährleisten. 

 Zusätzlich versucht man, die redundanten 
Systeme voneinander räumlich zu trennen. 
Dadurch minimiert man das Risiko, dass 
sie einer gemeinsamen Störung 
unterliegen. 

 Schließlich verwendet man manchmal 
Bauteile unterschiedlicher Hersteller, um 
zu vermeiden, dass ein systematischer 
Fehler sämtliche redundanten Systeme 
ausfallen lässt (diversitäre Redundanz). 

Die Software von redundanten Systemen sollte 
sich möglichst in den folgenden Aspekten 
unterscheiden: 

 Spezifikation (verschiedene Teams), 

 Spezifikationssprache, 

 Programmierung (verschiedene Teams), 

 Programmiersprache, 

 Compiler. 
 

 

remanent 

Remanente Daten sind gegen Datenverlust bei 
Spannungsausfall geschützt.  

Z.B. kopiert das Betriebssystem die 
remanenten Daten automatisch in einen Flash-
Speicher, sobald die Spannungsversorgung 
unter einen kritischen Wert sinkt. Bei 
Wiederkehr der Spannungsversorgung lädt 
das Betriebssystem die remanenten Daten 
zurück in den Arbeitsspeicher. 

Dagegen sind die Daten im Arbeitsspeicher 
einer Steuerung flüchtig und bei 
Unterbrechung der Spannungsversorgung 
normalerweise verloren. 
 

 



 

60 

ifm Programmhandbuch ecomatmobile Downloader 32 

Begriffe und Abkürzungen  

Restrisiko 

Das ist das verbleibende Risiko, nachdem 
Schutzmaßnahmen ergriffen wurden. Vor dem 
Restrisiko muss in Betriebsanleitungen und an 
der Maschine deutlich gewarnt werden. 
 

 

Risiko 

Als Risiko gilt die Kombination der 
Wahrscheinlichkeit des Eintritts eines 
Schadens und des Ausmaßes des Schadens. 
 

 

Risikoanalyse 

Kombination aus ... 

 Festlegung der Grenzen der Maschine 
(Verwendungszweck, zeitliche Grenzen), 

 Identifizierung der Gefährdung (Eingreifen 
von Personen, Betriebszustände der 
Maschine, vorhersehbarer Missbrauch) 
und 

 der Risikoeinschätzung (Verletzungsgrad, 
Schadensumfang, Häufigkeit und Dauer 
der Gefahr, Eintrittswahrscheinlichkeit, 
Möglichkeit zur Vermeidung oder 
Begrenzung des Schadens). 

 

 

Risikobeurteilung 

Das ist die Gesamtheit des Verfahrens, das 
die Risikoanalyse und die Risikobewertung 
umfasst. 

Nach Maschinenrichtlinie 2006/42/EG gilt: "Der 
Hersteller einer Maschine oder sein 
Bevollmächtigter hat dafür zu sorgen, dass 
eine Risikobeurteilung vorgenommen wird, um 
die für die Maschine geltenden Sicherheits- 
und Gesundheitsanforderungen zu ermitteln. 
Die Maschine muss dann unter 
Berücksichtigung der Ergebnisse der 
Risikobeurteilung konstruiert und gebaut 
werden." ( Anhang 1, Allgemeine 
Grundsätze) 
 

 

Risikobewertung 

Das ist die auf der Risikoanalyse beruhende 
Beurteilung, ob die Ziele zur Risikominderung 
erreicht wurden. 
 

 

ro 

ro = read only (engl.) = nur lesen 

Unidirektionale Datenübertragung: Daten 
können nur gelesen werden, jedoch nicht 
verändert. 
 

 

RTC 

RTC = Real Time Clock = Echtzeituhr 

Liefert (batteriegepuffert) aktuell Datum und 
Uhrzeit. Häufiger Einsatz beim Speichern von 
Fehlermeldungsprotokollen. 
 

 

Rückstellung, manuell 

Die manuelle Rückstellung ist eine interne 
Funktion des SRP/CS zum anuellen 
Wiederherstellen einer oder mehrerer 
Sicherheitsfunktionen. Wird vor dem Neustart 
einer Maschine verwendet. 
 

 

rw 

rw = read/write (engl.) = lesen und schreiben 

Bidirektionale Datenübertragung: Daten 
können sowohl gelesen als auch verändert 
werden. 
 

 

S 

SAE J1939 

Das Netzwerkprotokoll SAE J1939 beschreibt 
die Kommunikation auf einem CAN-Bus in 
Nutzfahrzeugen zur Übermittlung von 
Diagnosedaten (z.B.Motordrehzahl, 
Temperatur) und Steuerungsinformationen. 
 CiA DS 402 

Norm: "Recommended Practice for a Serial 
Control and Communications Vehicle Network" 

Teil 2: "Agricultural and Forestry Off-Road 
Machinery Control and Communication 
Network" 

Teil 3: "On Board Diagnostics Implementation 
Guide" 

Teil 5: "Marine Stern Drive and Inboard Spark-
Ignition Engine On-Board Diagnostics 
Implementation Guide" 
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Teil 11: "Physical Layer – 250 kBits/s, Shielded 
Twisted Pair" 

Teil 13: "Off-Board Diagnostic Connector" 

Teil 15: "Reduced Physical Layer, 250 kBits/s, 
Un-Shielded Twisted Pair (UTP)" 

Teil 21: "Data Link Layer" 

Teil 31: "Network Layer" 

Teil 71: "Vehicle Application Layer" 

Teil 73: "Application Layer – Diagnostics" 

Teil 81: "Network Management Protocol" 
 

 

Schaden 

Als Schaden bezeichnet man eine physische 
Verletzung oder Schädigung der Gesundheit. 
 

 

Schutzmaßnahme 

Maßnahme zur vorgesehenen Minderung des 
Risikos, z.B.: 
 - fehlerausschließender Entwurf, 
 - technische Schutzmaßnahme (trennende 
Schutzeinrichtung), 
 - ergänzende Schutzmaßnahme 
(Benutzerinformation), 
 - persönliche Schutzausrüstung (Helm, 
Schutzbrille). 
 

 

SCT 

Bei CANopen-Safety überprüft die Sicherheits-
Zykluszeit SCT (Safeguard cycle time) die 
korrekte Funktion der periodischen 
Übertragung (Daten-Refresh) der SRDOs. Die 
Daten müssen innerhalb der eingestellten Zeit 
wiederholt worden sein, um gültig zu sein. 
Andernfalls signalisiert die empfangene 
Steuerung einen Fehler und geht in den 
sicheren Zustand (= Ausgänge abgeschaltet). 
 

 

SD-Card 

Eine SD Memory Card (Kurzform für Secure 
Digital Memory Card; deutsch Sichere digitale 
Speicherkarte) ist ein digitales 
Speichermedium, das nach dem Prinzip der 
Flash-Speicherung arbeitet. 
 

 

SDO 

SDO = Service Data Object = Nachrichten-
Objekt mit Servicedaten. 

SDO ist eine Spezifikation für eine 
herstellerunabhängige Datenstruktur zum 
einheitlichen Datenzugriff. Dabei fordern 
"Clients" die gewünschten Daten von "Servern" 
an. Die SDOs bestehen immer aus 8 Bytes. 
Längere Datenpakete werden auf mehrere 
Nachrichten verteilt. 

Beispiele: 

 Automatische Konfiguration aller Slaves 
über SDOs beim Systemstart. 

 Auslesen der Fehlernachrichten aus dem 
Objektverzeichnis. 

Jedes SDO wird auf Antwort überwacht und 
wiederholt, wenn sich innerhalb der 
Überwachungszeit der Slave nicht meldet. 
 

 

Selbsttest 

Testprogramm, das aktiv Komponenten oder 
Geräte testet. Das Programm wird durch den 
Anwender gestartet und dauert eine gewisse 
Zeit. Das Ergebnis davon ist ein Testprotokoll 
(Log-Datei), auf dem entnommen werden 
kann, was getestet wurde und ob das Ergebnis 
positiv oder negativ ist. 
 

 

Sicherheitsfunktion 

Der Ausfall einer Sicherheitsfunktion einer 
Maschine kann zum unmittelbar erhöhten 
Risiko führen. Der Konstrukteur einer solchen 
Maschine muss daher: 
 - einen Ausfall der Sicherheitsfunktion sicher 
verhindern, 
 - einen Ausfall der Sicherheitsfunktion 
rechtzeitig sicher erkennen, 
 - Maschine bei einem Ausfall der 
Sicherheitsfunktion rechtzeitig in einen 
sicheren Zustand bringen. 
 

 

Sicherheits-Normentypen 

Sicherheitsnormen auf dem Gebiet der 
Maschinen sind wie folgt strukturiert: 
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Typ-A-Normen (Sicherheits-Grundnormen) 
behandeln Grundbegriffe, Entwurfsleitsätze 
und allgemeine Aspekte, die auf Maschinen 
angewendet werden können. Beispiele: 
Terminologie Methodik (ISO 12100-1), 
Technische Prinzipien (ISO 12100-2), 
Risikobeurteilung (ISO 14121), ... 

Typ-B-Normen (Sicherheits-
Fachgrundnormen) 
behandeln einen Sicherheitsaspekt oder eine 
Art von Schutzeinrichtungen, die für eine 
Reihe von Maschinen verwendet werden 
können. 

 Typ-B1-Normen für bestimmte 
Sicherheitsaspekte. Beispiele: Sicherheits-
Abstände (EN 294), Arm-/Hand-
Geschwindigkeiten (EN 999), 
Sicherheitsbezogene Teile von 
Steuerungen (ISO 13849), Temperaturen, 
Lärm, ... 

 Typ-B2-Normen für Schutzeinrichtrungen. 
Beispiele: Not-Aus-Schaltungen 
((ISO 13850), Zweihand-Schaltungen, 
trennende oder berührungslos wirkende 
Schutzeinrichtungen (ISO 61496), ... 

Typ-C-Normen (Maschinensicherheitsnormen) 
behandeln detaillierte 
Sicherheitsanforderungen an eine bestimmte 
Maschine oder Maschinengruppen. 
 

 

SIL 

Der Sicherheits-Integritätslevel SIL ist nach 
IEC 62061 eine Einstufung (SIL CL 1...4) der 
Sicherheitsintegrität der Sicherheitsfunktionen. 
Er dient der Beurteilung 
elektrischer/elektronischer/programmierbar 
elektronischer (E/E/PE)-Systeme in Bezug auf 
die Zuverlässigkeit von Sicherheitsfunktionen. 
Aus dem angestrebten Level ergeben sich die 
sicherheitsgerichteten Konstruktionsprinzipien, 
die eingehalten werden müssen, damit das 
Risiko einer Fehlfunktion minimiert werden 
kann. 
 

 

Slave 

Passiver Teilnehmer am Bus, antwortet nur auf 
Anfrage des Masters. Slaves haben im Bus 
eine eindeutige und einmalige Adresse.  
 

 

SRDO 

Über SRDOs (Safety-Related Data Objects = 
Sicherheitsrelevante Datenobjekte) werden die 
sicheren Daten ausgetauscht. Ein SRDO 
besteht immer aus zwei CAN-Nachrichten mit 
unterschiedlichen Identifiern: 

 Nachricht 1 enthält die 
Originalanwenderdaten, 

 Nachricht 2 enthält die gleichen Daten, die 
aber bitweise invertiert werden. 

 

 

SRP/CS 

Safety-Related Part of a Control System = 
Sicherheitsrelevanter Teil einer Steuerung 

SRP/CS ist ein Teil einer Steuerung, das auf 
sicherheitsgerichtete Eingangssignale reagiert 
und sicherheitsgerichtete Ausgangssignale 
erzeugt. Die Kombination sicherheitsrelevanter 
Teile einer Steuerung beginnt an dem Punkt, 
an dem sicherheitsgerichtete Signale erzeugt 
werden (einschließlich Betätiger z.B. eines 
Positionsschalters) und endet an den 
Ausgängen der Leistungssteuerungselemente 
(einschließlich z.B. der Hauptkontakte eines 
Schützes). 
 

 

SRVT 

Die sicherheitsrelevante Objekt-
Gültigkeitsdauer SRVT (Safety-Related Object 
Validation Time) sorgt bei CANopen-Safety 
dafür, dass die Zeit zwischen den SRDO-
Nachrichten-Paaren eingehalten wird: 

Nur wenn die redundante, invertierte Nachricht 
innerhalb der eingestellten Zeit SRVT nach der 
Original-Nachricht übertragen wurde, sind die 
damit übertragenen Daten gültig. Andernfalls 
signalisiert die empfangende Steuerung einen 
Fehler und geht in den sicheren Zustand 
(= Ausgänge abgeschaltet). 
 

 

Steuerungskonfiguration 

Bestandteil der CoDeSys-Bedienoberfläche. 

► Programmierer teilt dem 
Programmiersystem mit, welche Hardware 
programmiert werden soll. 

> CoDeSys lädt die zugehörigen 
Bibliotheken. 
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> Lesen und schreiben der Peripherie-
Zustände (Ein-/Ausgänge) ist möglich. 

 

 

Symbole 

Piktogramme sind bildhafte Symbole, die eine 
Information durch vereinfachte grafische 
Darstellung vermitteln. 

 Kapitel Was bedeuten die Symbole und 
Formatierungen? (→ Seite 5) 
 

 

Symbole und Formatierungen 

Ein Link ist ein Querverweis zu einer anderen 
Stelle im Dokument oder auf ein externes 
Dokument. 
 

 

Systemvariable 

Variable, auf die via IEC-Adresse oder 
Symbolname aus der SPS zugegriffen werden 
kann. 
 

 

T 

Target 

Das Target gibt das Zielsystem an, auf dem 
das SPS-Programm laufen soll. Im Target sind 
die Dateien (Treiber und ggf. spezifische 
Hilfedateien) enthalten, die zum 
Programmieren und Parametrieren erforderlich 
sind. 
 

 

TCP 

Das Transmission Control Protocol ist Teil der 
Protokollfamilie TCP/IP. Jede TCP/IP-
Datenverbindung hat einen Sender und einen 
Empfänger. Dieses Prinzip ist eine 
verbindungsorientierte Datenübertragung. In 
der TCP/IP-Protokollfamilie übernimmt TCP 
als verbindungsorientiertes Protokoll die 
Aufgabe der Datensicherheit, der 
Datenflusssteuerung und ergreift Maßnahmen 
bei einem Datenverlust.  

(vgl.: UDP) 
 

 

Template 

Template (englisch = Schablone) 

Ist eine Vorlage, die mit Inhalten gefüllt werden 
kann. 
Hier: Eine Struktur von vorkonfigurierten 
Software-Elementen als Basis für ein 
Applikations-Programm. 
 

 

Testrate rt 

Die Testrate rt ist die Häufigkeit der 
automatischen Tests, um Fehler in einem 
SRP/CS rechtzeitig zu bemerken. 
 

 

U 

Überwachung 

Die Überwachung ist eine Sicherheitsfunktion, 
die sicherstellt, dass eine Schutzmaßnahme 
eingeleitet wird, sobald Folgendes eintritt: 

 Die Fähigkeit eines Bauteils oder eines 
Elements, seine Funktion auszuführen, 
wird vermindert. 

 Die Betriebsbedingungen werden so 
verändert, dass das resultierende Risiko 
steigt. 

 

 

UDP 

UDP (User Datagram Protocol) ist ein 
minimales, verbindungsloses Netzprotokoll, 
das zur Transportschicht der 
Internetprotokollfamilie gehört. Aufgabe von 
UDP ist es, Daten, die über das Internet 
übertragen werden, der richtigen Applikation 
zukommen zu lassen. 

Derzeit sind Netzwerkvariablen auf Basis von 
CAN und UDP implementiert. Die 
Variablenwerte werden dabei auf der Basis 
von Broadcast-Nachrichten automatisch 
ausgetauscht. In UDP sind diese als 
Broadcast-Telegramme realisiert, in CAN als 
PDOs. Diese Dienste sind vom Protokoll her 
nicht bestätigte Dienste, d.h. es gibt keine 
Kontrolle, ob die Nachricht auch beim 
Empfänger ankommt. Netzwerkvariablen-
Austausch entspricht einer "1-zu-n-
Verbindung" (1 Sender zu n Empfängern). 
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Begriffe und Abkürzungen  

V 

Verwendung, bestimmungsgemäß 

Das ist die Verwendung eines Produkts in 
Übereinstimmung mit den in der Anleitung 
bereitgestellten Informationen. 
 

 

W 

Watchdog 

Der Begriff Watchdog (englisch; Wachhund) 
wird verallgemeinert für eine Komponente 
eines Systems verwendet, die die Funktion 
anderer Komponenten beobachtet. Wird dabei 
eine mögliche Fehlfunktionen erkannt, so wird 
dies entweder signalisiert oder geeignete 
Programm-Verzweigungen eingeleitet. Das 
Signal oder die Verzweigungen dienen als 
Auslöser für andere kooperierende 
Systemkomponenten, die das Problem lösen 
sollen. 
 

 

wo 

wo = write only (engl.) = nur schreiben 

Unidirektionale Datenübertragung: Daten 
können nur verändert werden, jedoch nicht 
gelesen. 
 

 

Z 

Zustand, sicher 

Der Zustand einer Maschine gilt als sicher, 
wenn von ihr keine Gefährdung mehr ausgeht. 
Dies ist meist der Fall, wenn alle 
gefahrbringenden Bewegungsmöglichkeiten 
abgeschaltet sind und nicht unerwartet wieder 
anlaufen können. 
 

 

Zykluszeit 

Das ist die Zeit für einen Zyklus. Das SPS-
Programm läuft einmal komplett durch. 

Je nach ereignisgesteuerten Verzweigungen 
im Programm kann dies unterschiedlich lange 
dauern. 
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